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Retail Business - an overview.
When Retail Business first starts it creates a systems administrator user profile - profile id '100'
and password 'mickey'. When prompted enter the profile id into the field on the POS logon
screen.
As follows:

To set up of Retail Business follow the sequence:
1. Edit the existing company control record. Much that is included here prints on the
receipts/dockets and invoices - including address, tax number and (optionally) email or website
address..
2. Set up the stock system. Setting up the stock system is the most important for retail use.
Sales and specials are also set up using Stock Management. To help make it easier to carry out
stock take it is also a good idea to organise your stock in lines/groups as you have them on the
shelves. So you may wish to set up stock lines and stock groups.
3. If you intend to use the POS menu buttons first set up the required stock items. These are
especially useful if you sell items (ice cream, milkshakes, vegetables, takeaways) that don't have
bar codes.
4. Configure the way the POS behaves by going to POS settings
5. If the Customer operations module is installed set up your regular customers. If you intend to
provide credit then set those customers up as "Invoice customers" and specify a realistic credit
limit. If you don't you will not be able to create invoices for those customers.
Once the company and stock items are set up you are ready to start using the POS.
The POS screen is designed to be used with touch screens and scanners.

Retail Business functions
Professionals Retail Business consists of two components - Stock Management and the point of
sale screen.
In Stock Management carry out stock and supplier management tasks.
You may have installed the optional Customer, Bookings or Workshop modules.
There are two main form types in Professionals Retail Business - Data entry and report forms.
1. Data Entry:

· You must use the buttons on each form to modify the contents of the fields. You cannot simply
go into the field you wish to change. Click Edit to edit an existing record, New to add a new
record. The fields are then activated. Generally the cursor will be placed in the first field to
enter.
· If adding or editing a record, and you want to exit, click Save or Cancel before exiting.
· Key (code) fields have a button beside them that displays a magnifying glass. View key
records by clicking the button. If the form is in edit or add mode you may select a record by
clicking on the "Select" button in the list form.
· Deleting records (such as stock items) is possible if there are no records dependent on that

item. For example once a stock item has been recorded as sold from Retail Business you can
not remove it. You can make it inactive (discontinued).
· If you are adding a record, and a key field is required, the save button is not enabled until the
key field has been entered.
· When entering certain fields the database is searched, as you enter data, for that code. This
means "........cannot be found!" displays until you have entered the correct code. Then the
description of the code displays beside the field.
2. Reports:
· Report forms allows the selection of a preview or print option.
· In preview you can print the report while looking at the preview.
· All reports work on certain key fields and a date range. Make sure you select the correct key
codes.
· When you select key codes their descriptions display. Make sure that is the correct description.
· Because most reports work on a date range (usually the date of the transaction) you may find
nothing on the report. This is one of the reasons for using preview before printing the report.
· To print many reports you need to have an A4 printer. Some reports relate to POS sales only
and have a 'receipt format' option.
3. Help:

· Help is available at any time. The help file is c:\PSL\RetailBusiness.chm. If you click on the file
Windows will run the help facility. You may place the file on your desktop.
· All forms have context sensitive help. To view the help information about any form, press the
F1 key when the form is activated.
· Some fields have hints attached. To view any hints move the mouse cursor over the field.

Starting Retail Business
You can start Professionals Retail Business from Start Menu -> Programs or from the desktop.
When you first start Retail Business the system administrator's profile is created and the
Company Control form activates. You can make additional changes to settings from the Retail
Business Settings form:

User profile id logons are required when first starting the POS software. The default system
administrator's profile is created when the software is first started. The id is "100", the password
is "mickey".
The main menu form now displays.

From this form you can carry out the required back office operations to manage Retail Business.
Select "POS and POS functions" to access the POS-related functions and start the POS.

This example shows that EFTPOS integration is enabled

POS settings
To control the way the Retail Business POS operates you need to configure it using the POS
Settings form. You should go to this form after you have set up Company Control.
For example, if you wish to use menu buttons - that is because you have items with no bar codes
- you need to turn them on before they will appear on the POS.
The six screen examples below show the range of settings possible and their affect on the POS.

1. Store wide settings:

This option can only be set if you are using the main settings form from the base system install.
Other wise there are more limited Lane settings to configure.

· You can ignore the box "Activate password access" as Retail Business always prompts for a
user's profile id when it first starts
· Check the box "Enable multi-item selection..." if you intend to set up items that consist of
multiple items. Some of which may be optional. This enables you to select items that go to
make up a complete 'package'. For example a kit that has a basic set plus additional
components. If you're not likely to do that leave it unchecked.
· "Only managers can open the till" should be checked if you don't want casual staff to be able
to open the till using the "Open drawer" button on the POS. The drawer will still open if the sale
is for cash. If you set this then someone with manager's, or above, access rights will need to
be available.
· Leave the box "Enable scanning on Cafe POS...' unchecked. It isn't relevant to Retail
Business.
· Check the box "Manager authorisation required for refunds..." if you wish to limit cashier
ability to carry out refunds and discounts.
· Check the box "Activate credit card payment surcharge" if you wish to recoup surcharges.
This will only work if you are confident you can "catch" credit card users. Enter the surcharge
percent. That will be added to the value of the total sale and will be included on the total to
tender on the tendering form. Cashiers must make sure they click the "Credit card" button to
complete tendering.
· If you don't wish to have ANY orders printed check the box "Turn off orders printing". This
setting over rides stock entry settings that would other wise result in orders being printed for
certain items. You can still print receipts if you wish.
· Check the box "Allow free sales/gifts/exchanges" if you think you will need it. Be warned.
This allows cashiers to "complete" a sale with zero value. To complete such a "sale" select
"Other tender" rather than the normal tendering selections.
· If your business is a cafe or takeaways, and you don't wish to use the receipt as the kitchen
order then check the box "Print orders when payment made". This does not over ride the
"Turn off orders printing". So one only should be checked. This prevents cashiers from
generating orders and then cancelling sales. If you check this button another field - "Print
orders how many times" displays. The default value is one. More than one is usefull if you
have differing people fulfilling different parts of the order.
· Check the box "Remove POS button if item discontinued" if you wish to make sure such
items disappear from the buttons immediately. Doing this allows you to "tidy up" the buttons
later.
· "Keep item buttons visible" is no longer relevant. Ignore it.

2. Lane settings.
These are specific to any lanes that are set up. The base system lanes setting also apply to the
POS if it is started from the base system computer.

· If you're using a bar code scanner and/or the menu buttons check the box "POS defaults to
auto mode". You really only need this unchecked if you have many items where you need to
change their prices as you enter them onto the docket. Even then it may not be required as the
POS makes it very easy to change prices.
· "Enable cashier switching on POS' is irrelevant to Retail Business. The correct way to do it
is to lock the POS by clicking "Change cashier". To unlock another cashier's id has to be
entered.
· "Include images on the POS buttons" is also irrelevant. You can add them at any time. You do
have to make sure the buttons are big enough - usually 4 times as large as the default. That is
- double width and double height.
· 'Activate cash drawer kicker" requires that you have a kicker attached to a serial port. You
need to know which comm port it is connected to. If you activate the kicker the receipt printer
will no longer open the drawer.
· "Enable menu sales buttons on POS" is unchecked by default. This enables you to carry out
sales using either manual entry, stock list selection or the bar code scanner while setting up the
buttons. Once they are set up check this box.
· If you have options for any items (eg takeaways like burgers, salads, etc) then check this box.
Options are set up from Stock Management.
· If you always have the same float amount enter it into the "Float amount" field. Allowance will
be made for that amount in the end of day calculations.
· If you have a networked POS system then enter the code of the department for each lane.
First set up the relevant departments.

3. Printer settings.
Printer settings have to be set for each lane.

· If you're using an A4-sized printer for receipts then check the box "Use A4 as default". If you do

·

·

·

·
·
·
·
·

·

use an A4 printer you will also need to use a drawer kicker for the POS to open the cash
drawer.
If your receipt printer is 57mm then check the box "Use 60mm receipt printer..." This applies if
you're using 57mm receipt rolls in a printer that can also use 80mm paper.
If you wish to supply large font (display) orders for kitchen staff then check the box "Activate
stock line kitchen display orders". You will need to format the orders forms as will. In addition
you need to make sure that all items have a line code added when you create, or maintain,
them in Stock Management.
Check the box "Include payment details on order" if you wish to make sure kitchen staff
complete orders that have actually been paid.
Check the box "Include spacer on orders" if you wish to have the spacer printed. The spacer is
generated when you click the button "Spacer ======" on the POS. It can be used to visually
define "groups" on the docket.
If your printer doesn't always cut the paper between orders and receipts check the box "Force
page cut after orders". This results in an Epson-compatible "cut form" command being sent to
the printer. If your printer isn't Epson compatible this command will no work.
Select the receipt printer from the dropdown list. Make sure its name is in the "Selected printer
is" field. You still need to have the receipt printer set up as the default printer for all POS
computers.
If you intend to print reports you need to install an A4 printer. Even if it isn't always connected
you still need to install the printer drivers for the one you intend to use. Select the printer from
the dropdown list and make sure it is in the "Selected printer is" field.
If you intend to generate bar code, or other price labels, install a label printer. The software
supports the Brother QL series, the Dymo Labelwriter and the Zebra LP series.
You can have up to 3 kitchen printers installed. The kitchen printer settings are only required if
you have a separate kitchen printer for kitchen staff. If you intend to print orders on the receipt
printer then select it as Kitchen printer (1). The other selections aren't required. If you have a
set kitchen printer, and want items to print on it you need to make sure those items have the
kitchen printer selected in the "POS response" button when setting up the items in Stock
Management.

4. Customer facing.
This defines how the POS displays, and prompts, for customer related actions and displays.

· If you have a LCD or LED customer display select the size of the display from the "Customer
display size" buttons.

· Select the way you want receipts to print. Or not. If you select “Always prompt for receipt” you
will have the option to print by responding "Yes" to a prompt.
· There is a default receipt message "Thank you for shopping at....". Uncheck the box "Disable
receipt default message" if you don't want this to print. Especially useful to do so if you set up
user-defined receipt formats.
· If you don't want the name of the cashier to display on the receipt uncheck the box "Blank "You
were served by..." on receipts."
· If you have a LCD/LED customer display you can activate a slide show that can be used to
display specials or other advertising. The images have to be in a folder on the local PC (if the
POS is being run on a network). This means each workstation needs to have their own slide

folder. Select the folder, All images (they need to be JPEG files) in the folder will be displayed
in a sequence. They will display in the bottom half of the customer display.
· If you have a picture you want to display select the image file from another local folder. This
can be something like your business logo or some form of advising - eg specials. This picture
displays at the right side of the customer display.
· Ignore the field "location of active tables layout". This only applies to users of the hospitality
suite.

5. EFTPOS integration.
This tab allows you to configure certain EFTPOS terminals to work with the POS.

· To activate EFTPOS integration check the box "Turn on integrated EFTPOS." Additional fields
now display to enable you to set things up.
· Select the type of integration - based on your EFTPOS provider - from the dropdown list

· Several of these are now obsolete and will be replaced by current ones as updates are made
available
· You can leave the field "Your merchant id" empty unless you are using DPS Payment Express.
In which case it must be provided.
· Select the communications port the terminal is to connect to. This is required for ALL serialconnected terminals.
All the above settings have to be done, individually, for any networked POS counters.

6. Auto backup.
Make sure you have a USB memory stick installed for this to work

· To select the drive make sure the USB memory stick is installed. Then click the Get drive
button. It is not a good idea to keep removing the USB drive once it is installed as Windows
may assign another driver letter to it and the backup attempt will then fail.

· Ignore the "Start time". That is currently not active. Instead the back up will occur when you
shut down the POS and are prompted to carry out the back up.

7. Setting up checkout scales.
· Go to Company Control and check the box "Activate checkout scale". That activates
"Change scales setting" button in POS Settings.
· Click the button "Change scales setting". The following form activates.

· Select your scale from the dropdown list. Professionals Retail Business supports the following
checkout scales: 1. CAS PD II and SW-1C. 2. Ohaus Aviator 7000. 3. Wedderburn DS-866,
770, 771, 781, 788 - NCI ECR protocol. 4. CAS AP-1 price computing. 5. Magellan 8300/8400
scanner scale.
· Select the communications port it is connected to. Warning - if using USB connections you are
advised to not remove the connection. As Windows may allocate another communications port
number when reconnecting.

8. Setting up kitchen display orders.
Click the button "Display orders format". The following form activates.

· You can configure for either 57MM or 80MM orders. There are three sections to the order:
1. The "order id". This is the order/docket number. It includes the customer's name if you
allocated a walkin customer to the docket.
2. The "order heading". This is the date and time of the order, plus the server/cashier's name.
3. The "item description". Self-explanatory. You can make the item's font size quite large. But
doing so will result in a lot of paper being used.
You can optionally include the stock line with the order numbers - this is only useful if you have
enabled stock line display orders in POS settings. It results in orders being divided between
stock lines. So you also have to make sure all items have a stock line allocated.

9. Setting up store sales.
In "POS settings" you can set up store-wide sales. These over ride all other specials. As well as
customer discounts Click the button "Activate store sales". The following form activates.

· Set the start and finish dates. As you change the start date the finish date changes to be 7
days after the start. You can change the finish date to be something else.
· Set the percent discount.
· Set the description. This shows at the top of the POS screen once the sale becomes active. If
you leave it blank it will not be obvious to cashiers that there is an active sale
· Once you're ready to activate the sale check the box "Check to activate sale between....."

10. Setting up Hospitality menus and services
To activate the menu buttons on the POS you must first set up at least one menu.
You can have multiple 'specials' menus as well as the usual - eg - Dinner, lunch, breakfast. The
specials can be, for example, Children's birthday, 21st birthday, St Patrick's Day, Chinese New
Year, Ramadan, etc. Menu items can be shared between menus so there is no need to jump
from one menu to another in the POS. If an item is on multiple menus just include it on whichever
menu it is on.

Click "New menu" to create a new menu:

•
•
•
•

Enter a description. This is required and displays on the menu selection list on the POS.
When you click 'Change menu'.
If a menu-wide discount is to be applied enter the percent into "Apply
discount/special". If you do all items from the selected menu will have the same
discount applied.
Leave the box "Menu is active" checked.
Click "Save".

If you have the Bookings module installed: Set up services with specified times. When entering a
reservation, and selecting a service, you will be warned if the service selected does not cover the
period the reservation is for. This is done from the Reservations form. These services are
different from the POS menus as not all menus may be able to have reservations. So only set up
those services that do.
If set services are set up, and assigned to a reservation, they are added to the docket when the
party's reservation is assigned to the active docket by clicking 'Assign party' on the POS..

•
•
•
•
•
•

The create a new service click 'Add'.
Enter a unique code.
Enter a description. This is used to enable selection. So make sure it's distinct from any
other, similar, services.
Enter the start time as the 24-hour clock. Eg 9.00am is 0900, 1.30pm is 1330.
Enter the stop time as the 24-hour clock.
Click 'Save'.

If the service has a set menu click 'Service menus'. The following form activates:

To add an item click 'Attach item'. The following form activates

•

•

Either enter the stock code or select from the stock list.
If you wish the item to be printed on a kitchen printer order check the box 'Send to
kitchen printer'. That will be assigned when the service is attached to the POS docket.

Setting up Bar Sales
If you wish to track the actual level of drink stock in terms of the volume stocked then use Bar
Sales. Other wise you can use the normal menu buttons.
To set up bar sales buttons:
1. Create a stock line for each type of drink shown on the bar sales form.
2. Link each drink to the relevant stock line. Make sure the unit of measure (Unit) is "serve". Or
"bottle" if that is the unit being served. If using the menu buttons then use something else like
glass or, more generally, "Unit". Which may be a glass or a bottle.
The bar buttons set up form is as follows:
{bmc HospBarSalesNewButtons.bmp}
All modifications to stock lines and items can be done from this form.
First set up the matching stock lines. You need to do this to link the item buttons to the correct
sale type (line).
{bmc HospBarSalesStockLines.bmp}

Create the bar sales items:
{bmc HospBarSalesNewItem.bmp}
To create a set of buttons - select the stock line that matches the line button you have highlighted.
{bmc HospBarSalesNewGroup.bmp}
Once the line has been selected click the "Connect" button.
{bmc HospBarSalesItemsConnected.bmp}
All items that have been linked to the line selected are placed on the buttons. You can have up to
45 items for each line.
To add additional items first click the "Disconnect" button to clear the existing items.
Select the stock line again and click "Connect".
If you wish to draw down the stock level by volume then enter the measure of each in the
"Measure (in ml)" field. Be aware - if you enter values into this field you will need to re-enter them
if you need to reconnect after adding new items.

Lane settings
If you have installed the network version of Retail Business the main form for each workstation
will include a button "Lane settings".
You must configure items such as cash drawer kickers, printers, scales, customer displays and
EFTPOS terminals using the lane settings. Because those use devices that are attached to the
relevant work station.

1. Lane settings
These can only be activated from networked workstations. Not the PC with the base system
installed. That uses global settings.

· If you're using a bar code scanner and/or the menu buttons check the box "POS defaults to
auto mode". You really only need this unchecked if you have many items where you need to
change their prices as you enter them onto the docket. Even then it may not be required as the
POS makes it very easy to change prices.
· "Enable cashier switching on POS' is irrelevant to Retail Business. Unless the Hospitality
module is installed. Other wise the correct way to switch cashiers is to lock the POS by clicking
"Change cashier". To unlock the POS a valid cashier's id has to be entered.
· "Include images on the POS buttons" is also irrelevant. You can add them at any time. You do
have to make sure the buttons are big enough - usually 4 times as large as the default. That is
- double width and double height.

· 'Activate cash drawer kicker" requires that you have a kicker attached to a serial port. You
need to know which comm port it is connected to. If you activate the kicker the receipt printer
will no longer open the drawer. Therefore connect the cash drawer cable to the kicker
· "Enable menu sales buttons on POS" is unchecked by default. This enables you to carry out
sales using either manual entry, stock list selection or the bar code scanner while setting up the
buttons. Once they are set up check this box.
· If you have options for any items (eg takeaways like burgers, salads, etc) then check this box.
Options are set up from Stock Management.
· If you always have the same float amount enter it into the "Float amount" field. Allowance will
be made for that amount in the end of day calculations.
· If you want the end of day to calculate based on lanes then select a department for each lane.
First set up the relevant departments and make sure you define them as lanes. With this
setting the end of day, when run from the base system PC, completes a consolidated cash
summary fro all lanes.
2. Printer settings.
You can use networked (shared) printers. But be aware that, if the store is very busy, there may
be delays in obtaining receipts.

· If your receipt printer is 57mm then check the box "Use 60mm receipt printer..." This applies if
you're using 57mm receipt rolls in a printer that can also use 80mm paper.
· Select the receipt printer from the dropdown list. Make sure its name is in the "Selected printer
is" field. You still need to have a receipt printer set up as the default printer for all POS
computers.
· If you intend to print reports you need to install an A4 printer. Even if it isn't always connected
you still need to install the printer drivers for the one you intend to use. Select the printer from
the dropdown list and make sure it is in the "Selected printer is" field.
· If you intend to generate bar code, or other price labels, install a label printer. The software
supports the Brother QL series, the Dymo Labelwriter and the Zebra LP series.
· You can have up to 3 kitchen printers installed. The kitchen printer settings are only required if
you have a separate kitchen printer for kitchen staff. If you intend to print orders on the receipt
printer then select it as "Kitchen printer (1)". The other selections aren't required. If you have a
set kitchen printer, and want items to print on it you need to make sure those items have the
kitchen printer selected in the "POS response" button when setting up the items in Stock
Management.
3. Customer facing.
Not all workstations need to have a customer display. So you can leave it disabled for those that
don't have one.

· If you have a LCD or LED customer display select the size of the display from the "Customer
display size" buttons.
· Select the way you want receipts to print. Or not. If you select always prompt for receipt you
will have the option to print by responding "Yes" to a prompt.
· There is a default receipt message "Thank you for shopping at....". Uncheck the box "Disable
receipt default message" if you don't want this to print. Especially useful to do so if you set up
user-defined receipt formats.
· If you don't want the name of the cashier to display on the receipt uncheck the box "Blank "You
were served by..." on receipts."
· If you have a LCD customer display you can activate a slide show that can be used to display
specials or other advertising. The images have to be in a folder on the local PC (if the POS is
being run on a network). This means each workstation needs to have their own slide folder.
Select the folder, All images (they need to be JPEG files) in the folder will be displayed in a
sequence. They will display in the bottom half of the customer display.
· If you have a picture you want to display select the image file from another local folder. This
can be something like your business logo or some form of advising - eg specials. This picture
displays at the right side of the customer display.
4. EFTPOS integration
EFTPOS integration must be configured for each cashier lane. It is possible that some EFTPOS
terminals can be shared (Smart Pay's is one) but you need to check with your provider.

· To activate EFTPOS integration check the box "Turn on integrated EFTPOS." Additional fields
display to enable you to set things up.
· Select the type of integration - based on your EFTPOS provider - from the dropdown list

· Several of these are now obsolete and will be replaced by current ones as updates are made
available
· You can leave the field "Your merchant id" empty unless you are using DPS Payment Express.
In which case it must be provided.
· Select the communications port the terminal is to connect to. This is required for ALL serialconnected terminals.
All the above settings have to be done, individually, for any POS lanes.

Using Retail Business POS
Processing sales
The point of sales form appears as follows in auto mode. The menu buttons are activated.

Note - not all 120 menu buttons are active. This is because some may have no items attached to
the menu.
To process a normal sale (that is a sale on auto - single item) carry out the following sequence:

· Enter, or scan, the bar code. If there is no bar code enter the stock code. You can also selct
from the stock list - click "Stock list". Or click the appropriate button on the menu buttons.
· To delete an item from the docket list click the Clear item button. Or click Clear docket if you
wish to remove all entries.
· To change the menu items to select click the relevant menu button on the left. The item buttons
will display all stock item descriptions for those items belonging to the relevant menu button.
You can set up up to 120 items. See "Setting up POS buttons" for how to set the buttons up.
See “Using the POS buttons”.
· As you click the relevant item button the item displays on the docket list. The default number to
be sold is one. To increment the quantity to something else press the appropriate number
buttons on the right of the screen then click the "X" button and select the item from the buttons.
Or just keep clicking the item's button. The quantity is added as you do so. Unless the item is
a kitchen item. In which case there will be a single line for each item.
· Keep scanning/entering/clicking buttons until you have finished.
· Click either the Tender EFTPOS, Tender Cash, Credit card, or Tender Cash / EFTPOS
buttons. If another form of payment - cheque, offline EFTPOS or Coupon - is being tendered
click the Other Tenders button.

Manual Mode
In manual mode the POS appears as follows. Note that there is now a To Auto button. As well
as an Accept button.

• If you are in manual mode, and use the menu buttons, the POS behaves as if it is in auto

mode. That is, the selected items are added to the docket list.
• In manual mode you need to select the item from the stock list or scan the code into the Item
code/PLU field.
• The keypad buttons change the quantity.

Refunds
• If an item is being returned for a refund add the item to the docket then click the Refund /
Credit button. The item's sale value switches to minus and the description reads "Return of.......".
• You may include returns as part of a normal sale. For example if the customer returns an item
sold for $12.50, you may record that as a refund and then add another item at $12.50. The net
effect is to update the inventory - the returned item is placed back in inventory and the
replacement is taken out. In that case you need to allow free sales/ returns in POS settings.
· If the "sale" is for a return/credit only clicking Refund/ Credit results in a minus docket value.
Select the payment type as normal. If repayment is by EFTPOS you need to have your
merchant's card to authorise it.
· If the transaction is for a refund/credit the POS appears as follows:

To complete the refund you can either select cash tender or EFTPOS. You need a merchant
card to complete an EFTPOS refund.

The POS function buttons.
The group of buttons to the right of the docket list are the most used functions.

· To clear a selected item from the docket list click "Clear item"
· To clear the entire docket of all items click "Clear docket". If you are dealing with an
incomplete sale you must use “Clear item”.
· When you do either of the above the item is "returned" to the inventory.
· Click "Exit POS" to return to the POS functions form. You cannot close the POS if there are
items on the docket. Either clear them or put them on hold.
· To switch to manual mode click "To manual". That button then becomes the "To auto"
button. If the default mode is on auto you can still switch between manual and auto. If in
manual mode the POS waits for you to enter a quantity when you scan, or enter, a
barcode/code PLU.

· To open the cash drawer click "Cash drawer". If you've limited cashier access to this a
prompt appears and requests a manager's id and password.

· The blank button is the "Accept" button if the POS is in manual mode.
· To clear POS fields (when in manual mode) click "Clear". This will both clear the contents of
those fields and return the POS to the state it was at previously.

· To process a refund click the "Refund / Credit" button. See above for the process to follow.
· To include additional text for an item (instructions or some such) click "Item text". The
following form activates.

· The item's description is included. You can replace it with new text. Or add the text.
· If you don't have a keyboard attached click "Keyboard" to activate the touch keyboard.
· To arrange payments by other than cash, EFTPOS or credit card click the "Other tender"
button.
· If the entire docket is to be discounted then click "Docket discount". The following form is
activated.

· To review, and optionally reprint, and deal with uncompleted sales dockets click "Review
sale". In addition you can select a docket to refund all the items on that docket. The following
form activates.

· If you reprint a sales docket it will include "Duplicate receipt".
· You can select an incomplete docket for completion by clicking "Complete/clear docket".
· If you click "Refund docket items" the POS will appear as follows. Complete the transaction
as a normal refund.

· If the Customer module is installed a button labelled "Customers" is visible. Click this to
activate customer operations.
· The POS appears as follows:

· Eight additional buttons are now visible - "Quotes", "Action center", "Lay bys", "Invoice
·
·

payments", "Register", "Delivery", "Loyalty rules", "Customer operations". Each will be
described in detail in “Customer operations.
The close the buttons click "Close customers". You need to do this to reactivate the other
functions buttons.
To change cashiers, or lock the POS, click "Change cashier". The following form activates.

· Enter your pin/cashier id.

· Click "Manage stock" to access stock operations. The POS appears as follows:

· The following buttons are now visible: "Manage stock", "POS buttons", "Stock take",
·
·
·

Requisitions", "Quantity labels", "Weight labels", "Export", "List orders". These will be
described in detail in Stock management.
If you click “POS buttons” and change the buttons layout you need to switch to another set of
buttons to see those changes.
To print the current docket as an order click "Print orders". If you have defined different items
to be printed on different printers then multiple orders may be printed.
If you wish to separate items on the docket into groups click "Spacer ======". The docket will
look something like the following:

· If checkout scales are activated you can obtain the tare weight of a container prior to the item
being weighed. Click "Get tare" and place the container on the scale. Do not use the scale's
own tare facility.

· If you set tare the POS appears as follows:

· Notice the extra line at the top of the docket list reading "The next weight items tare will be
0.054". In addition the "Get tare" button now reads "Clear tare 0.054"

· Once the item has been weighed you MUST clear tare or it will be applied to the next item you
weigh.

· If you use table number tags you can associate a customer order with that number. Click
"Table tag". The following form activates and the tag number displays at the top of the POS
docket.

· To include comments (other than options) on the docket click "Comment". The following form
activates.

· Enter the comment and press "Accept". An additional line containing your comment is added
to the docket.

· There must be at least one item on the docket for you to include a comment. The comments
are included on the receipt and any order you generate. Comments can therefore be used as a
form of instruction to order staff. Or the customer.

· To change the number of items for any one item click "Change quantity". The following form
activates.

· Enter the new quantity and press "Accept". If you don't have a keyboard use the touch
keypad. The new quantity replaces the existing quantity.

· To enter a percentage discount for a single item select the item on the docket and click "%
disc". The following form activates.

· To enter a dollar discount click the "$ disc" button.

· Click "Accept" to update the net price of the selected item. Or "Cancel" to cancel the action.
· If a discount has already been applied you may not apply another. Clear the item and select it
again.
· Click "Change price" to replace the default price. You cannot do this if the item already has a
discount applied. The following form activates.

· This form shows all existing prices that have been allocated to this item. In this case - cost
price, trade price and retail.
· You can select one of those by clicking the relevant button. Or enter another price manually.
· To park/hold the existing docket click "Parked dockets". The docket will be cleared and
placed on a held dockets list.
· To release a held docket click "Parked dockets". But only if there are, currently, no items on
the docket list. The following form activates.

· This list contains all sales that have been put on hold. The example is, almost certainly, not
what you should do.
· It is a good idea, at the end of the day, to go to this list and release and clear all dockets
remaining.
· The right hand side list shows the contents of the selected docket.
· If you selected a regular customer for the docket their name appears in the name column.

· It is highly unlikely you will ever need to use "Tax exempt". It only applies to tourists who are
·

here long enough to obtain a sales tax exemption. In that case they need to show
documentation.
"Lay bys" enables you to review existing lay bys and create new ones. You need to have
created regular customers. Click it and the following form activates.

· For more details on dealing with lay bys see Managing lay bys
· If you can’t find an item on the buttons (maybe it hasn’t been put there yet) and/or it doesn’t
have a barcode to scan you can list, and select, stock items. Click "Stock list". If stock lines
are in use the list appears as follows.

· If you have selected a regular, credit allowed, customer you can complete invoice payments for
that customer by clicking "Invoice payment". The POS then is as follows

· There is a summary of the selected customer’s credit situation at the top of the docket.
· Click "Invoice list" to select the invoice. The invoice number is placed in the code field, or
enter it manually. The total due is in the Payment field. You can make partial payments.
· Click "Reg Cust" to select a regular customer you intend to associate the docket with. When
you have selected a customer the button becomes "Clr cust" so you can remove them from
the docket if you need to.
· If you wish to pay someone out of the till then click "Cash pay out". This is not the same as
"Cash out". "Cash pay out" is a record of an expense.

· Cash pay out must be the only item on the docket. You may not add any items if you enter
one. Nor may you make a cash pay out if the docket already includes items.
· Enter the amount of the pay out using the number pad keys and click "Accept". The following
form activates.

· You must include a description of the pay out.
· Then click "Other tender". You will be prompted for a receipt.
· If you allow customers to carry out cash outs only then you can click "Cash outs". These are
handled as a single entry and must be completed using the EFTPOS payment option.

· Enter the amount of the cash out and click "Accept".

· Click "EFTPOS" to complete the transaction.
· To print a tag the docket must be associated with a regular, or walk in, customer - that is a
customer's name must be at the top of the docket. You can add a table number as well.

With the Hospitality Module installed

The menu buttons are now restricted to a maximum of 96 rather than 120. In addition there is a
hospitality-specific set of buttons to the right. In the above example Booking is not enabled so
two buttons (Assign Party and Close Party) are not visible.
To change menus - eg Dinner menu, Breakfast menu - click 'Change menu'. The POS will look
something like the following:

Note the "Select menu" list. When a selection is made the list disappears. If no selection is made
click “Change menu” to make the list disappear. The default is for the POS to display menu
selections for the first menu you set up. Make sure wait staff know to check the selected menu
when they first start up the POS.

Editing or Adding Data
All data entry forms are set up in a similar fashion. When adding or entering data the following
applies on all forms:
1. When the "Add/New" button is clicked all but the Cancel buttons are disabled. And all fields
are cleared. When compulsory information has been entered the "Save" button activates.
2. When the "Edit" button is clicked all but the "Save" and "Cancel" buttons are disabled and the
required fields are active for editing. In certain forms (for example the stock management edit
form) fields such as the Stock Code cannot be edited as they are used by other parts of the
software to link data.
3. You cannot exit a form if in add or edit mode. If you need to click save or cancel first.
4. Move from field to field using the Tab key. Do not use the Enter key. The fields are set up so
that pressing the tab key takes you to the next.
5. You cannot enter anything in certain fields. Such fields are displayed because they can be
used to search for records. The data in them is generated by the system and is used to link
tables or to create unique keys that decrease the chance of user errors. For example invoice
numbers. You can enter the first number in the company set up, but after that the system
generates new invoice numbers.
6. Many forms have data grids on them. These provide a view of several records at once.
7. When you click on the "Add" or "Edit" buttons another form will pop up. If certain fields have
the correct codes entered into them the "Save" button becomes active. Then the status bar
displays "Browsing data". If you are interrupted check there for the current status of the form.
You don't have to bother with any of this on the POS form
8. Click the "Cancel" button if you make a mistake. This returns the fields to their previous
contents if you are editing them, or to the current record if you were adding data.
9. Certain fields have a button beside them with a magnifying glass in it. Use this to select a key
code from a list of records. When you are adding a new record, or editing, you may select a code
to display in the relevant field.
10. Most forms include at least one search panel. Use this to search for key fields such as stock
codes, customer accounts, invoices, and suppliers.

Pick Lists
All pick lists work in the same manner. To activate a list click the magnifying glass button to the
right of the relevant field. If adding, or editing, a record the code may be selected and appear in
the code field. If browsing the lists are view only.
If the code may be selected the Select button is visible. Highlight the relevant record and click
the select button. This returns you to the data entry form with the code in the relevant field.
If you do not wish to select the highlighted record, click the Close button.
Some lists provide access to the maintenance form of the records being viewed. To activate that
form click the New button. Once you have made the required changes the new data is available
on the pick list.

Customer tabs
Select a regular customer (as in this case) or enter a name for a walk-in customer.
Add items to the docket

Click the "Manage tab" button. The following window appears.

Click "New tab" if the customer doesn't have one already. Or "Add to tab" if they do.

•
•
•

•

If the customer is a regular their customer code and name is already on the form.
The date the tab is opened defaults to the current day.
Enter the maximum amount permitted on the tab. This will provide a warning if the
customer exceeds the maximum. Or is getting close to it.
Enter the means used to identify the customer. In this case it is "regular cust'. Other

•

•

means may be driver's license, passport, bank card.
If not a regular customer there should be an id number - eg. From their driving license or
passport.
Click "Make tab". When you do a tab ticket prints on the receipt printer. The customer
should keep this to enable quick identification when they want to add to the tab. Also to
help prevent the creation of unnecessary tabs.

If using a touch terminal with no keyboard attached click the "Keyboard" button to activate the
touch keyboard.
If the tab is for a walk-in customer creating a new tab may look something like the following:

If the customer already has a tab open then click "Add to tab". The following form opens:

•

•
•
•

Select the tab from the list.
Click "Add".
The form closes and a new docket is created.
Note that there is no need to preselect the customer on the POS.

To close a tab:
Make sure there are no items on the POS docket list.
Click "Manage tabs" then "Close".

•

Select the relevant tab from the list.
Click "Close and pay". The form will appear as follows:

•

Select the payment method. See Processing EFTPOS sales for how the payments form
operates.

•

Managing old tabs.
Tabs are a debt. Retail Business enables you to recover them by invoicing customers who have

them. For this to work you must make sure you convert walk-in customers into regular customers
and enter their postal address and/or their email address.
On the POS click "Admin" then "Tabs Management".
The following form activates.

From this form you can create invoices. But only if the customer is a regular and has been set up
to allow invoices. That means they must also have a credit limit set up.
If this form's list is large then you need to review who, and how, you authorise tabs.

Bar sales buttons
If you wish to track the actual level of drinks stock in terms of the volume stocked then use Bar
Sales. Other wise you can use the normal menu buttons.
To set up bar sales buttons:
1. Create a stock line for each type of drink shown on the bar sales form.
2. Link each drink to the relevant line. Make sure the unit of measure (Unit) is “serve”. If using
the menu buttons then use something else like glass or, more generally, “Unit”. Which may be a
glass or a bottle.
The bar sales set up form is as follows:

The group of buttons on the left are “placeholders” for the stock lines required to link the relevant
stock items to the buttons on the right.
All modifications to stock lines and items can be done from this form.
First set up the stock lines to match the “placeholders” on the left. For example – a “whiskey”
stock line for the “Whiskey” placeholder. A “Cocktails” stock line for the “Cocktails” placeholder.
You need to do this to link the item buttons to the correct sale type (line).

Create the bar sales items:

To create a set of buttons - select the stock line that matches the line button you have highlighted.

Once the line has been selected click the "Connect" button.
The buttons display in the order they were created.

•
•
•
•

All items that have been linked to the line selected are placed on the buttons. You can
have up to 45 items for each line.
To add additional items first click the "Disconnect" button to clear the existing items.
Select the stock line again and click "Connect".
If you wish to draw down the stock level by volume then enter the measure of each in the
"Measure (in ml)" field. Be aware - if you enter values into this field you will need to reenter them if you need to reconnect after adding new items.

When the bar sales buttons have been set up, and you select “Bar Sales” from the Hospitality
function buttons, the following form activates:

•
•

Select the line and then the item. When you do the form closes and activates the
"Change quantity" form.
Enter the quantity if it differs from 1. For example if the drink is by shots, serves or
glasses.

If no change is required click "Cancel".

Reservation parties
Reservations can be connected to POS dockets. To be able to do this you must have the
Bookings module installed. This is a good idea if the party has made a booking for a ‘standard
service’. The items attached to that service are placed on the POS docket when the party is
assigned to the docket.
1. Enter bookings into the Bookings form for the day in question.
2. Click the "Assign party" button on the Hospitality functions panel. The party's booking must
be for the current day.

The service defined for the party's booking does not have to match the current restaurant service.
If the party's service has a set service the items attached to that service are placed on the
existing docket. The number of items is based on the size of the party defined when you entered
the reservation. You can manually change those quantities if you need to.

To close the party's booking click "Close party". The following form activates:

Click "Close party" and the reservation is removed from the list. You can not assign the party's
reservation to any further docket as only open reservations are shown on the ‘Assign party’
listing.

Setting up Retail Business
Retail Business has to be set up in a particular order. The set up order is as follows:
When you first start Retail Business the Company Control form activates.
additional changes to settings from the System Settings form:

You can make

1. Set up your company. Review, and modify the company that is pre-installed.
2. Departments/lanes are optional. If you wish to set up cashier lanes, and want to track sales by
lane, then set up a department/lane for each workstation. This is especially useful if your shop is
split into sections so that customers always use the same counter for certain items. This allows
you to keep a track of the performance of each department.
3. To arrange just in time ordering, or if you want to make orders, create the required supplier
records. If you intend to run just in time restocking you need to set up suppliers so you can
arrange supplier orders.
4. Set up the inventory. You may wish to create stock lines and groups first if you wish to report
by stock categories It is possible to load stock items "on the fly" from the POS using the stock
list.
5. Set up a cashier profile for each cashier. Only people with administrator level access can
carry out the end of day cashup and change POS button settings.
6. Configure the POS Settings.
7. Set up the menu buttons These are especially useful if you have items with no bar codes or
wish to include options for any items
8. Create any regular customers. These can be created on the fly in the POS by activating
Customer Operations.

With Hospitality Module Installed
Notice that there are additional buttons – Bar drink settings, Booking services, Floor layout and
Menus.

9. To create any bar drinks settings first make sure the those drinks are set up within the stock
inventory. Bar drinks are designed to enable you to track actual stock levels in detail as drinks
are sold. That includes mixers.
10. Booking services allows you to define the menus customers can pre-book.
11. Use Floor layout to create a plan of your shop floor and include all tables. Doing so allows
you to track table status from the main POS form.
12. Use Menus to link menu buttons to set menus. First define the menus and then link to the
relevant menu selections and items.

Company Set up
Edit the company record. You must replace "Name" in “Company name” with your business
name. Also change the “Description”. Both print on the POS receipts

· Company name is included on the top of reports and receipts. If you leave "Name" in the field
the startup wizard activates every time you start Retail Business. Change the name to your
company name.
· Enter a description of the company. This prints below the company name on receipts. It can
be something like "For all your electrical needs", or "Fresh vegetables every day."
· Include your address details. There is no field set aside for postal zone. Include that in the

same field as you enter your city/town.

· Complete the sales tax component if you are registered for G.S.T. or V.A.T Your tax number

·

has to be printed on receipts so you need to include it. You must also include the default tax
percent as that is used to calculate the sales tax component on sales The default 'Accounting
basis' is "Payment'. You can leave that as it is.
If you want the software to generate customer codes for you check the box "Auto generate
customer codes". The form then has an additional field - "Last customer number".

· Make sure, if you already have customers set up, that the number doesn't duplicate any
existing numbers.
· To activate the system save function check the box "Activate system save on shutdown".
This is only triggered when the base system is shut down.
· The company logo is required if you are billing regular customers and wish to include it on
invoices. You need to have the Retail Business customer module installed.
· If you have a checkout scale, and have it installed and configured for the POS check the box
"Use checkout scale". This will mean the POS will connect to the scale when it starts up.
· If the Bookings module is installed the box "Activate customer bookings" is checked by
default. You can turn it off if you don't wish to allow cashier access until you are ready.
· "Default income account" can be left blank. Unless you're using the back office accounting
functions. In which case set it to whichever ledger account you wish end of day banking to be
credited to.

Setting up sales tax
Set up sales tax if your business is registered. All departments of a company share the sales tax
set up unless it is disabled for any department.
{

Enter the correct information in the relevant fields.

· For sales tax to be calculated when entering transactions check the Registered box.
· The number/code displays on receipts.
· The Exclusive field is not relevant to Retail Business

· The No. of Months field is not relevant to Retail Business.
Payments Basis:
Use this option.
Hybrid Basis :
Not relevant to Retail Business.
Invoice Basis:
Not relevant to Retail Business POS. Unless you are using the back office accounting functions.

Department/Lanes Set up
Professionals Retail Business allows multiple departments/lanes for your company (up to 9999).
Departments are optional.
For descriptive purposes the name of the department should be filled in (the name is printed on
reports).
The department form appears as follows when in browse mode:

· There are three compulsory fields. Code, Name and This is a lane.
· Code is used to search for the department, and as a key field in transactions.
· Name is used as part of headers on reports and to identify the department a ledger account
belongs.

· If you want the department to act as a lane check This is a lane. The default, when creating a
department, is not checked. Once the department has been defined as a lane you can allocate
it to the required lanes by using Lane Settings on each lane's computer. The department's
name is used instead of the company name on receipts.
· The other information (address, etc) is for your own purposes.
If you set up a department as a cashier lane you can obtain end of day totals for each lane. If you
have more than one lane for any department then the end of day cash up is for all lanes that
belong to that department.
You can still obtain a total end of day cash up for all lanes by using the back office computer.
Providing it hasn't, also, been set up as a lane.
Once you have defined the department as a lane you can then attach it to the relevant cashier
lanes. To do that open Retail Business, then Select POS interface and click "Lane settings".
The following form activates.

Select the relevant lane's code for the field "Department for this lane". Click Save.
You must use Lane Settings if you have multiple lanes and use the integrated EFTPOS option.

Supplier Maintenance
It is not necessary to create any suppliers unless you wish to run just in time ordering, generate
orders and report on margins.

· Compulsory fields are: Supplier code and company name.
· The Registered for G.S.T. is not relevant in Retail Business as you will only be entering
orders.
Suppliers can be searched for by business name or code.

User security and cashier profiles
Use this form to set up cashiers and their level of access. Once set up a cashier can be
deactivated so they are unable to access the system.
Before setting up the cashier think about what they data they need access to. If you do not give
anyone but the administrator such access you will need to create additional codes when
requested. This may slow down data entry and can become quite a nuisance.
· If you are the only user, stay with the initial administrator's access.
Be careful when creating passwords. Don't use pet names, car models, or anything like that.
The system prevents the use of user names. Valid characters in a password are the following:
capitals (A...Z) and lower case (a...z), numbers, and the underscore.
When a user is first created make sure the password expires on today's date or the date they will

first use the system. This forces them to change of their password when first logging on. Only
the administrator can change passwords that have not expired. Decide whether to expire
passwords. Doing so improves security, so long as users do not put copies of their password in
their top draw. But it can annoy users, and result in simple, and easily solved, passwords.
Do not remove the system administrator's profile. It is created when the software is first
installed. At least one other person should have administrator's rights; or at least know what the
administrator's logon id and password are.

If the user is not to use the system immediately uncheck the "Active Password" box.

· If you wish to record cashier details you can do so by clicking "Staff details". The following
form activates

· Once the user has been set up neither their name nor number can be changed. Everything
else can be changed.
· Retail Business tracks all cashier activity. To view, and clear, the log click the "Security Log"
button.

New cashier
· Click the "New User" button. This will create a new user number with all other fields blank.
The user number is automatically created and cannot be changed.
· Enter the first and last name. Both are compulsory. Click "Save".
· If the cashier is to start using the software immediately check the "Active Password" box.

Access levels
There are three access levels.
· The default level is 3 "Periodic user - Retail Business, Operations, reports and inquiries".
These users can maintain Receipts, Cash Transactions and produce reports and view the client
and supplier inquiry forms. They may not create, or change, any stock items or suppliers.
· Level 2, "Transaction Data Entry. No set up forms". These people can create and maintain
stock items, orders and suppliers.
· Level 1 (Administrator) can maintain company control, all set up forms, departments/lanes and
maintain user security.

Change Passwords
· To create the password click "Change". Enter a valid password and repeat it in the Repeat
field.
· If a user forgets their password it can be changed by selected their profile and clicking the
"Change" button, entering, and repeating, the new password, then clicking "Confirm". If the two
passwords are not identical they must be re-entered.

Expiring Passwords
· Passwords can be expired so the user can no longer use their current password as at a certain
date. They must enter a new password. A new password expiry date is created based on the
number of days set when the user was first set up.
· If the password is to expire check the "Password Expires" box. "Number of Days" and
"Expires on" fields display. Change the "Number of Days" field and the expiry date changes.

Security logging
Retail Business maintains a comprehensive record of cashier actions. To review them go to
Cashier Profiles and click the "Security log" button. The following form activates:

· The default is to list all actions taken within a 7 day period. For all cashiers up to the current
day.
· To view the actions of a selected cashier uncheck "All cashiers" and select the relevant
cashier.
· To select an action uncheck the box "All actions" and select an action from the list.
· You can print the selected list by clicking the "Print" button. Make sure you have switched the
default printer to an A4.
To clear the log - it can get quite large - click "Clear all events".

Utilities
The tools form provides a range of housekeeping operations. Read the detailed help from the list
below to see how to carry out those operations correctly.

Backing up Retail Business
This process completes a complete back up of Retail Business. If backing up to a CD/DVD make
sure it has no data on it and is rewritable (RW). If backing up to a memory stick you can create
folders.
This process should be run at least once a month. You can run it immediately before switching
Retail Business to another PC. In that case make sure you install Retail Business on the PC first.
The system back up form appears as follows:

Select the relevant drive from the drop down list. Make sure the correct media is already in place
before starting this form. USB ports with a memory stick attached and CD/DVDs show as drives
in the list.

Recovering full back up
This tool enables you to restore a full system backup. This may be necessary if you are often
getting error messages about the indexes (and an index rebuild fails). Or you have switched to
another PC, have installed Retail Business correctly (by running the install executable) and now
wish to recover the entire database.
The system recovery form is as follows:

Make sure the recovery media is in place before selecting it from the dropdown list. Once the
process has started it cannot be interrupted while recovering. If you do interrupt it there is a good
chance that the system will not operate correctly as some records depend on others to display
correctly.
· Make sure there is a folder/disk in the "Recovering from...".
· Make sure the "Restoring to....." folder is correct. It should, in most cases, be "C:\PSL\
Database". The above example is using a networked drive.

List Forms
List forms enable you to view key data and, under certain circumstances, to add or edit new
records and to include a code within a record you are editing or creating. Most list forms provide
a means of maintaining the relevant records.

Departments

Use this form to select between departments.
department to lane settings.

It is activated when you wish to allocate a

Suppliers
If the supplier does not exist you can create them by clicking the Suppliers button. Once you
have finished the display shows the new supplier.

If there are a large number of suppliers you can find them by typing in part of the code or
company name. As you type the records are searched for the nearest match and the display

updates to show those that fit.
This list is activated from the stock maintenance form and when entering orders.

Selecting a file
This form is activated when you need to select a file. The most likely use is when loading a logo
to be included on receipts.
The list on the left shows the files within the folder selected on the right. When you select a file its
full position is displayed in the "File to import is" field. If you are sure you have the correct file
click the Open button.

To restrict the type of files to display select from the file types list at the bottom right.

Stock selection lists
There are several stock selection lists. The ones activated from the POS are designed to help
you find stock items quickly. As well as display critical information so you can answer customer
questions. For example: how many items in stock, any on order, what the per unit price is.
To activate the selection list click Stock List on the POS. The following form activates if you have
set up stock lines and groups:

This form allows you break the display based on a selected stock line. To activate that option
uncheck the Display all items box. Then select the required stock line in the Code field.
You can change the order items display in by clicking a title at the top of the list. "Stock code",
"Supplier", "Line" and "Description" can have their display order changed between ascending and
descending.
To search for items enter start entering the text you want to search for into any of the search
fields. As you enter more characters the search narrows down the available results. The search
ignores case. Code and description do not search unless "Go" is clicked. You can enter a partial
match and the list will search for the closest when "Go" is clicked

Stock lines and groups
Stock lines
This list is activated from the stock maintenance form. Use it to find lists and groups (if required)
to select lines when running the stock lines and/groups reports and when creating stock items.

Stock groups
This list is activated in the stock maintenance form when adding or editing a stock item. It
displays the groups attached to the already allocated stock line.

You can create a new group from the list by clicking "New".

When things go wrong
You get "Index is out of date", "Index is corrupted" messages, or reports are no longer in the
correct order. In that case use the Recover the Database tool.

Registering Retail Business
If you have a demonstration version of Retail Business you are limited to a maximum of 100
transactions. In addition, if you obtained the demonstration system with the data already in it, you
cannot install a clean system without registering.
Every copy of Retail Business has a registration key. It is provided when you purchase. In
addition you need the registration number to enable the full system. To obtain the number
contact Professional Systems on (09) 432 8904. If you have not paid no registration number will
be provided.
To register Retail Business on the main form go to POS settings -> Unlock Retail Business

If you have updated your software with additional modules you need to re-register with the new
registration key you are provided when you are advised of the download..
The modules that have been installed are shown in the "Installed packages" group.

Frequently asked questions FAQ
I want to register for on-going support and updates. How do I do that?
· Contact Professional Systems through our website www.ProfessionalSystems.co.nz
· If you have just purchased Professionals Retail Business, and have registered, you are
automatically covered for support and updates for one year from the date of registration.
I can't delete a stock item.
This is only possible if the stock item has never been included in one of the following - a POS
sale, a stock order.
What are those funny buttons on the right of a lot of the fields? They allow you to start up a
list of the item required in that field and to select the correct one.
How do I set up sales/discounts/promotions? See Stock management and POS Settings
Things seem to be slowing down when I run reports. What might the trouble be?
· Not really a problem, but the database may be getting quite large. If you have a lot of
transactions every year, and have been running Retail Business for several years, the main
transactions tables may be quite large by now. It may be time to update/upgrade your
hardware. Or run Housekeeping to clear records no longer required.
The software takes a long time to start up. What could be causing that?

· If you are running Retail Business over a network it is possible there are road blocks if the
network is a 10 megabit one. If it is 100 megabits, or more, things should start quicker. Retail
Business has been designed to run quite quickly over a network once the active form has
loaded. But the result is that the actual load could take a little time on slower networks or
where there is a lot of network traffic. It is likely that running Housekeeping and clearing old
sales records will speed things up.
I can't seem to load the logos.
A few things could be wrong here:
1. The files are the wrong type. They must be bit map files. They end with the extension .bmp. If
you have a logo that is either a gif or jpg file open it in Paint then select File -> Save as and save
as type bmp.
2. The files have the wrong name. The sales receipt must be called logoss.bmp.
3. The logo files are in the wrong place. They must be in the folder C:\PSL\Database\images
A word of warning. The Windows Explorer has a setting that hides the extensions. This means, if
you name a file logoss.bmp, and the extension is hidden, you could actually have named it
logoss.bmp.bmp. To make the extensions visible start Explore (right click Start -> Explore) select
Tools, then Folder Options. Go to the View Tab and scroll down to the check box Hide
extensions for known file types. Uncheck the box then click Ok.
My pole display keeps losing communication with the PC.
This is a Windows port problem. Most pole displays are serial. If you connect it to a USBl port on
the PC it is possible that Windows will not recognise it. This is because while COM1 is visible as
a port it may not be allocated to the actual serial port. Get a USB to serial converter and install it.
I've configured the POS buttons, and activated them, but they don't appear on the POS
screen.
Either the screen resolution is not correct or the screen is to small. Go to Control Panel ->
Display (settings) and change the resolution to 1048 by 768. If the display can't be changed to
that resolution you need to get a new video card. If the resolution has been changed and the
buttons still aren't visible then the screen is to small. You need to get a 17 inch screen. Don't get
one of those "wide screens", get a square one.
I'm in the POS screen and want to set up regular customers. How do I do that?
Click the "Customers" button and click "Customer Operations". If the "Customers" button is
not on the POS then you don't have a license that includes the Customers module.

Using the POS Buttons
If you have activated the POS buttons in POS Settings you will notice some buttons at the left of
the POS screen. That is if you have linked stock items to any button. Each menu button can
have up to 120 items. If the Hospitality module is installed the number is 84. As you press each
button the item is added to the docket list. To change the quantity click Change Qty after the
item has been added. Or click the 'X" on the number pad, followed by the quantity you wish, then
select the item.
The menu button form appears as follows:

The above example is for ice cream.

Tendering sales payments
There are two forms for processing tendering of payments. The Other tenders form and
"normal" tendering (Cash, EFTPOS, Cash/EFTPOS and credit card).

Other tenders
If the customer wishes to pay using another method than cash or EFTPOS - credit note/refund,
coupon, off line EFTPOS - website, invoice, credit note - click the Other tenders button. The
following form activates:

Note - "Cheque" is there for legacy purposes. It will, eventually, be removed.
If a regular customer has been selected from the POS the Other tender form appears as follows:

Note - the "Invoice/ cr. coupon" and "Redeem cr. (Not coupon)" buttons are now active.
Select the payment (tendering) preference.
If the tendering method is a combination of coupon and EFTPOS the tendering form appears as
follows:

Enter the coupon value first. The EFTPOS value is calculated as you do so. The Cash/Coupon
option operates in a similar manner. With the exception that the cash value is rounded.
If tendering coupons only the form appears as follows:

The above example assumes that you provide cash change when the value of a coupon exceeds
the value of the sale.
"Mobile EFPOS" and "Mobile EFTPOS/Cash" enable you to enter payments for deliveries that
have been either paid for on delivery or were paid for prior to delivery. You can also use the
"Offline sale" option. Although that is better used to deal with EFTPOS payments made through
websites or if the EFTPOS terminal lost communication with the POS.
If the customer is a credit customer, and you are providing them with a credit note, click the
"Other tender" button. The following form activates:

As you can see there is a choice of either "Credit note" or "Pay out". Payout is if you intend to
pay cash for returned items.
If you select "Credit note" the Other tenders form appears as follows:

NOTE - the "payment" must be a for a negative amount. That is, enter each item into the POS as
a refund. Or, better yet, and to avoid having item stock levels inaccurate, create a special "Credit
note" item. But don't set it up as a stock item.
Click "Accept" to complete the transaction. Credit notes may be viewed in the Customer
operations form. The list is also used to specify which credit note is being drawn down as credit
is redeemed. Customers can have credit notes without being set up as "invoice" customers.
However, if they're not set up as an invoice customer you cannot complete a transaction by
selecting the "Invoice/cr. note" option in Other tenders.
To drawn down existing credit notes make sure you have the correct customer selected in the
POS. Then click "Other tenders" and click "Redeem cr. (Not coupon)". When you do the
following form activates.

You will prompted to allocate any balance of the credit to transactions you did not select. The
result may be to drawn down the total of one credit note while resulting in a decreased balance in
one or more others.

Tendering sales

Payments tendering can be carried out by clicking one of the four green buttons to the right of the
docket list.
The "$" amount buttons on the tendering form ADD the value on the button to the amount in the
active field. That is $1.00 plus $2.00 results in $3.00. The number buttons on the right add the
numbers AFTER the number already entered. So "1" plus "3" is "13".
The tendering form also behaves slightly differently depending on which of the number buttons
you click:
1. If you click the "$" buttons the tendering form completes the sale as soon as the amount
equals, or exceeds, the amount of the sale. So, if tendering cash of $5.00, as soon as $5.00 is
clicked the tendering form closes and the sale completes.
2. If you click the number buttons on the right the "Accept" button becomes visible as soon as
the amount being tendered equals, or exceeds, the amount to tender. Unless an EFTPOS or
Credit card is being used to pay. In that case the "To pin pad" button is active.
If "Cash" is clicked the following form activates:

You may not complete the sale unless the Total tendered exceeds, or equals, the Balance due.
If you allow cash out then enter the cash out amount into the relevant field.
If tendering cash, and change is required, the "change" popup displays to show the amount of
change. If you are using EFTPOS, Credit card, or the Cash/EFTPOS combination the total
tendered must equal the total due.

If EFTPOS is selected the tendering form appears as follows if EFTPOS integration is enabled.
Click "To pinpad" to activate the pin pad. Once you do the form appears as follows:

This is for Verifone VxLink Two-way. Other terminals provide a complete "running commentary"
of the terminal display. You can include cash out.
If you select two tendering (Cash/EFTPOS) methods the form appears as follows:

The above example is for a combination of cash and EFTPOS. Changes to the Cash field (using
the buttons or typing direct) result in the EFTPOS field showing the balance amount owing.
If the customer is paying by more than one payment method, and one of them is cash, you have
the option of calculating the non-cash component first. This helps if the customer doesn't know
how much they can pay in cash and you need to be able to tell them the balance to pay in cash
as you enter the total for EFTPOS. To do that click the "Enter here" button.
The tendering form appears as follows:

To activate the non-cash field click "Enter here first". From then on all alterations in the noncash field result in the cash field displaying the balance due. Use the numeric buttons on the
right hand side to enter the amount
For coupons it is possible to give change if the value of the payment exceeds the amount due.
If you select Cash the total is rounded. That means you only need to change the amount to be
paid if the customer requires change. In that case press the Clear button and use the number
buttons to enter the amount they are tendering.
If you have selected "Always prompt for receipt" in POS settings the prompt will appear

If change is due the change prompt appears:

Parking, and releasing, sales receipts
Parking a sales receipt allows you to put aside a sale while the customer gets another item. And
still serve other customers in the queue. If you do that is is a good idea to get their name and
attach it to the docket. Click "Walkin customer". If they are a regular customer then click "Reg
cust".
To park a sale click the Parked docket button, after you have entered at least one sales item.
The sale is immediately removed from the docket list.
To release a parked sale click the Parked docket button. When there is nothing on the dockets
list. If there is either clear it or complete the sale.
A selection form activates. It may be a good idea to read off a couple of the detail lines to confirm
you have the correct receipt if there is more than one. Select the receipt to release. Once you
have done so you may add, change, or remove items.

Parked dockets can be released in any cashier lane. This means a customer can switch lanes
and their receipt, created by another cashier, can be released by the cashier of the lane they are
now in.
At the end of the day there should be no parked dockets. If there are release and clear them.
If the docket is for a regular customer their name appears in the "Name" column. As does the
name of any walk in customer you linked to a docket.

Using the numeric keypad
The numeric key pad enables you to preset the quantity for the next item. Click the 'X" button
then the number and then select the item by either using the scanner or menu buttons.

It also activates when in manual mode and when carrying out expense pay outs.
When processing customer invoice payments the "X" button becomes a "Clr" button so you can
clear the total amount being paid if required.

End of day processing
Open this form from POS functions by clicking End of day. You have to be logged on to Retail
Business and have the required access rights. When first opened the cash up totals are based on
today's date. You can change the date. To cash up for the previous day make sure:
· No one is logged on to Retail Business and
· The date is for the current day, if you are running it on the same day. Or the previous day if for
that day.
If you change the date click the Refresh button to update the amounts.

The Cash in drawer total is calculated based on the total cash in minus change and any cash out
or cash expense payments. Check this total matches the actual cash in the drawer minus the
daily float amount.
If you change the date the check amounts are zeroed. In that case click the Refresh button
To calculate the drawer balance click Calculate. The following form opens:

When you click Accept the amount displays in the Total Cash field of the Cashup form. This
total is minus the float amount. If you use the calculator be sure to include the total in the till including the float.
To validate the float balances against actual transactions click the Audit button.
You may wish to manually verify the amount to bank. Don't forget to subtract the current/next
day's float(s) total.
If you manually count the day's takings enter the amounts (as cash, cheques, and coupons) in the
fields on the right. The coupons field is for cross-checking purposes only. A discrepancy figure is
calculated as the amounts are entered.
If there is a discrepancy you are prompted to bank the Drawer Balance rather than the To
deposit total.

Housekeeping
Housekeeping is activated from POS Settings.
This menu provides two options:
· Clear out sales records no longer needed. Running this periodically clears up space on the
disk and, in a network environment, increases transaction response times.
· Transfer older transactions to the library. This means they are still on the database. But only
accessible from the library reports. Those transactions are then deleted from the live
transactions. Running this option clears ALL transactions. Including today's.

Once the records have been cleared you cannot recover them unless you have a recent back up

archive.
The transaction clearing option allows you to select the date to clear to.

Warning - do not run housekeeping unless everyone is off the system.
You can also save old transactions to a library. This allows you to report on those transactions
from the library report option.

The sales report menu includes a button - Library reports - to activate the library-based reports.
These reports will be as complete as the date you last updated the library.
The library reports menu is as follows:

These three reports are identical, in layout, to the matching reports with the current data.

Sales reports

There are over 20 sales reports available. All reports provide for a selection based on inventory
item, and by date. As a result there is an extensive range of information available.
1. Cash sales - all, or selected, inventory items. Up to, or between, selected dates. This report is
useful for assessing how popular any item is.
2. Department/lane report. This report allows you to look at how much has gone through any
single lane. For this report to work you need to first set up department/lanes, then, using Lane
Settings, connect the relevant tills to the required Department/lane.
3. Cashiers - sales value by cashier. This can be used to assess performance payments if you
have them. If everyone uses the same logon it is another way of getting a cash sales report.
4. Sales Statistics - what percentage of sales any stock item is. By value and by number sold.
You can use it to assess whether there is any point continuing to stock an item.
5. Lines and groups - this is the same as the sales statistics report. But you can select lines and
groups to report on. Useful to find out if line and group sales were successful. For this report
to work stock items MUST include links to both the stock line and group codes.
6. Customer sales. By selected customer and between selected dates.
7. Coupon sales. Allows you so see how many coupons have been issued.
8. Coupon balances. It also provides a balance on any amounts still oustanding on coupons you
have issued.
9. Free coupon creation. If you allow cashier to complete free sales (those with zero dollars
owed) then run this regularly to make sure things are under control. This lists all free coupons
you have created. Use it to provide a summary to reimbursement.
10. Customer loyalty points. This provides a summary view of customer loyalty balances and
allows you to keep a handle on what future drawn downs in terms of costs you may have to
deal with. Run it regularly is you are running a loyalty scheme.
11. Stock turn. This report requires that stock is ordered, and fulfilled, using stock orders. It
calculates an average duration based on stock orders for the relevant items made up within
the period selected. For this report to work you must use supplier orders and not delete them.
At least for the current year.
12. Library-based reports. Library reports use data from archived sales records. To add to the
archive select Housekeeping -> Copy transactions to library. This process must be run when no
one else is using the system. The archived records are removed from the live system. If you
have a large number of transactions (15,000 or more a week) it is a good idea to run this monthly.
Or even weekly.

13. Sales by supplier. For this to include any information you must include the relevant supplier
code in the Supplier code field of Stock Management.
14. By payment type. This report duplicates the audit report the end of day cash up process
generates. The main difference is that you can select a date range.
15. Report of sales for items that have multiple links to other items. This report enables you to
report on items that are linked using the "Alternate code" in stock management. Situations where
this may be useful are where certain items may be purchased together, but not always. So
setting up a package is not required. For example certain toys, and accessories, may be bought
together. Or certain clothing items. Setting up this link allows you to find out if that is, indeed, the
case.
16. Margin analysis. For sales to date, or between two dates. You can report for all stock items
sold, or for a selected one. This report sums the value of all sales (actual prices) and the cost
(buy) price of those items and provides a total (for each item) of the margin. If your discounts
are too generous this report will provide the information you need to set more realistic
discounts
17. Stock lines. Use this report if you have items attached to stock lines but not groups.
18. Stock lines and groups. Use this if you have divided lines into groups
19. Library reports only relate to cash sales. The selection form is as follows:

To view sales graphs use the Dashboard

Reviewing sales
To review a completed sale click the Review button. You can reprint the selected docket.
The review form appears as follows:

The sales are in date order. With the most recent at the top. Use this to verify that a return item is
legitimate if the customer has lost the sales slip but knows the date of the purchase, and the
amount. Other wise it will be rather difficult to find a specific receipt.
To refund a complete docket click "Refund docket items". All items on that docket are added to
the POS with negative values. Tender the docket as a normal refund.
You may reprint the receipt of the selected sale when you click Reprint selected.
If the docket does not have a "Type" it means it was not completed for some reason or other.
When that happens the button "Complete / clear sale" is active. Click it and the incomplete sale
is placed on the docket. You may either complete it or clear it - to do so click "Clear item" until
all the docket is clear.
If there are any uncompleted sales you will see a message “There are X uncompleted sales”
when the POS first starts up.

Installing Retail Business cashier lanes
A cashier lane can be installed on PCs that have access to the Retail Business data through a
network. By default one lane is installed as part of Retail Business. However you can install
cashier lanes once Retail Business has been installed. Providing you purchased the workstation
module.
To install the workstation follow the instructions below:
1. Install Retail Business Base System on the PC you want to use as the server.
2. Make sure the database folder (by default C:\PSL\Database) can be shared. To share the
folder go to File Explore (right click the Start button), select the folder C:\PSL and right click it.
Select Advanced Sharing, click the Share tab then check the Share this folder box if it is not
already checked. Then click Ok.

On Windows 7/8/10 PCs you will need to specify that the folder can be shared by "everyone".
You may need to create such a user as Windows 10 doesn't create an "Everyone" by default.
3. On the PC the lane is to be installed on start (right click Start) File Explorer and select "This
PC". Then "Map network drive"

4. Find the drive of the PC Retail Business base system was ally installed on by clicking the
Browse button. If you cannot find it it is possible the connection to the PC was dropped. The PC
Retail Business is on may need to be shut down and restarted if the drive cannot be reconnected
by double clicking it. Make sure you select the DRIVE - not the folder.
Once the shared folder displays in the Folder field, check Reconnect on Logon, click Finish.
The Retail Business database is now connected to the Retail Business PC.
5. Install Retail Business workstation. Do not change the default settings.
6. You will have been provided a link to download the file Wkstn.exe. Run this program and
select the network drive you defined in step 4.
From now on, so long as both PCs are running, Front Counter can access the Retail Business
data it needs to run.
If the base system PC drops the connection you may need to reboot both computers. In that
case start the base system up first. Then the lane PC.

Stock management
Stock management functions allow you to:
· Create bar codes for stock items that don't have them.
· Load stock from other software or supplier price lists. Including a previous version of
Professionals Retail Business.
· Update existing stock prices from supplier price lists and Excel files.
· Manually maintain stock items.
· Set up stock to be replenished when it gets to a certain level.
· Set up stock item, and grouped, specials.
· Set up promotions - multi item discounts, Volume discounts/price breaks, item specials and
group sales
· Create item GST "holidays"
· Produce price labels and tickets - with and without bar codes.
· Carry out stock take - by line/group or entire inventory.
· Produce supplier orders.
· Discontinue stock when it reaches the end of line. Or is no longer stocked.
· Set up stock packages - that is stock items that consist of other stock items
· Set up stock lines to enable summary reports by line and/or group.
· Set up stock items to be weighed using a checkout scale.
· Set up item options buttons.
· Set up combo deals
To load an empty inventory from a supplier price list click "Load from file". Make sure you have
the latest price list before going any further. If you have already loaded the price list and your
supplier has provided you with a new price list click the "Update from file" button.
The inventory can be set up as either general items, books or clothes (additional fields are
visible). The default settings are general items. To change them go to Stock Control and check
the Include book lists box
Stock can be created "on the fly" when viewing the Stock list from the POS. To do so click "New
item" on the list form.

You can also change details for the item - for example if the price needs to be changed - by
clicking "Edit item"
Stock management can be activated on the POS by clicking the "Manage Stock" button. Which
then becomes "Close stock".

·
·
·
·
·
·
·
·
·

To manage stock items click "Manage stock"
To maintain the POS buttons click "POS buttons".
To carry out stock take click "Stock take"
To maintain stock requisitions click "Requisitions"
To consolidate customer stock orders into supplier orders - click "Process orders"
To maintain supplier stock orders click "Supplier orders".
To generate weight and quantity labels click either "Weight labels" or "Quantity labels"
To export the stock list click "Export". This allows you to export the stock list to an Excel
(CSV) file.
To list current orders click "List orders". This report requires you have an A4 printer attached if
you intend to print it. It shows both customer and supplier orders

Stock maintenance
To maintain stock items double-click the selected item. Or click the "Edit" button. To add an item
click "Add".
The following form activates.

Take some time to examine the features of this form as its settings are crucial to how the POS
deals with stock items.
There are four tabs:
1. Stock Items details. Many fields on this tab are compulsory. For basic operations this is the
tab you need to complete correctly.
2. Item sales details. This controls item sales/specials and receipt printing and order
destination.
3. Item restocking. This controls whether you wish to run just-in-time reordering.
4. Item picture. Use this to link a picture to the item.

Stock item details
· Bar code is not compulsory. If you use it you may enter an existing bar code (off the product)

·
·
·

or enter a new one - in which case enter 12 numbers and then click Barcode check digit. If
the stock code is the same as the bar code click button with the red arrow to the right of the
field. Both fields must be unique.
Code/PLU is compulsory and must be unique. It must also be no shorter than 4 characters.
Supplier's stock code is not compulsory. Use it if you intend to send stock orders and the
supplier uses code that differ from the barcode. In which case that code is used in the order
when it prints.
Line is not compulsory. If you want to report by departments/categories then use line. It is also
used to produce the end of day summary sales report. It is also necessary if you intend to set

up group sales. Lines can also be used to organise your stock take.

· Group is not compulsory. However, to organise group sales you will need to use it.
· Enter a description. This displays on receipts, stock buttons and the relevant reports.
· New stock is only required if you need to manually adjust stock levels. It is only visible if the
item is being editing. If the stock level is a negative value, and should be positive enter a New
stock amount that equals the negative amount PLUS the number that matches the level you
actually have.
· Supplier is not compulsory. Use it if you intend to report on supplier stock sales and to send
orders. You need to create the required suppliers first.
· Buy price is not compulsory. However, to calculate margins, you need to enter it. It is also
updated when you complete an order for the item.
· Trade price is not compulsory.
· Retail price is not compulsory - it is, however, required if the item has a price and is not to be
set up as an option
· Takeaway is not compulsory. Use it if you make a distinction between "Eat in" and
"Takeaway". In which case the default price will be retail and you will need to click "Change
price" in the POS to apply the takeaway price.
· Distributor price is not compulsory. Use this if you arrange sales to distributors. As with
Takeaway price you must click "Change price" in the POS to apply it.
· NOTE - all the prices, if entered, display on the change price popup form in the POS.

· Unit is "Unit of measure" - eg Kg, Ea, gm, litres, meters. This displays on the receipts.
· On order displays the number on order - from any orders you may have set up that have not
been fulfilled.

· Has been discontinued can be used to warn staff this item should no longer be used. Its

·
·

selection in the POS will result in a warning. It may be removed from the item buttons by
checking "Remove discontinued items from buttons" in POS settings. Discontinued items
display as a yellow bar in stock selection lists and in Stock management
Is a package is checked if the item is part of a package.
Non-stock item. Default is not checked. if you check this the POS will not update stock levels

when the item is sold.

· Style. Use this to help identify stock like clothes, shoes, etc. Displays as part of the stock item
·

·
·
·

details selection.
Alternate search code. Use this to link items that are, in many ways, identical but differ in
minor ways that mean you need to enter them as individual items. Eg - books with the same
title but differing prices and styles - paperback, hard covers, large print - and you want to be
able to report on the over all popularity of the title.
Distributor. This is only used for clothes and books.
Colour - clothes only.
Add description. Use this to include, for example, Chinese characters. If anything is entered
into this field it displays on the POS button if one is set up.

If adding a large number of items click "Save and add" to remain on the stock maintenance form.
That helps to speed things up.

Item sales details

· Extras prompt. Check this if you wish to have a prompt popup on the POS that reminds
cashiers of something. For example the need for batteries. A special coming up. The prompt
appears as follows when the item is sold from the POS.

· Select the date the prompt is to be active until.
· Check the box "Do not apply loyalty points to this item" if loyalty points aren't to be applied.
The default is to apply them.
· "Warn on discount" should be checked if you wish to prevent accidental discounts being
applied. This applies if the customer has a set discount rate.
· Ignore "Turn on optional price display" is irrelevant as all active prices now display on the
change price popup.
· Select the relevant option in POS response. The default is "Normal". That means the item will
print on the default receipt printer. If you have a separate kitchen printer select one of the
Kitchen printer options. You need to set up the printer in POS Settings. If the item is to be
weighed, and you have a checkout scale, check "Weigh item".
· To limit the ability of cashiers to apply discounts to the item enter a value in the "Discount limit
(0 is none)" field.
· If you want the POS to activate the Change price prompt automatically check "Variable price
prompt"

Setting up specials.

· Check the box "On special" The form will appear as above.
· Enter the discount amount/rate. You can, of course, only apply either a percent discount or a
flat amount.
· Enter the date the special starts.
· Enter the date the special finishes.

Item restocking
This tab enables the setting of minimum stock levels, order levels and warnings

· Check "Generate replenishment orders" to enable the generation of orders when stock
·
·

reaches the level selected. See Replenishing stock
Enter the "Minimum stock level" to generate orders and warnings
Enter "Minimum order level". This is the level that will be ordered by default. These levels
can be changed by editing the relevant order.

Stock level warnings take the form of red bars in Stock management and stock selection lists. In
addition, if the item is on an item button, that button has a red box around it when the warning
level is reached.

Stock item pictures
This tab enables you to link a picture to the item. It is a good idea to store all pictures in the same
folder. You may also use pictures that are to be used on the item buttons. However that is
probably only practical if you don't have cashier lanes. Other wise keep them separate. That
means the picture used here can be larger than the one attached to the buttons.

· Click "Load" to select the picture file.
· Click "Clear" to remove the image.
As you can see from above the picture can be larger than the ones that are to go on the buttons.
If you do intend to place pictures on buttons set things so the button can be made twice as high
and twice as wide.

Supplier stock orders
Use stock orders to place orders with your suppliers and to update the inventory. You can email
stock orders to your supplier. Before using stock orders enter your customer number/code
against the relevant supplier in Stock Configuration
To create a stock order select the supplier. Include a description of the order if you wish to. For
example if the order is for a particular job.
If the item being ordered is not currently in the inventory it will be created when you save the line.
If selecting existing inventory items make sure the relevant item is linked to the current supplier. If
it is not you are warned and will not be able to save the current line.

·
·
·
·

Order number is obtained from the stock configuration settings and is created automatically
Enter a description. This helps to identify the order when selecting from lists.
Select the supplier. All stock items in the order MUST already have that supplier attached.
Enter the date of the order. The default is the day it is created.
· The order defaults to not invoiced. If you create a supplier invoice when you have finished the
order the box will be checked. Once an invoice has been created from an order you cannot
create another one from that order.
· Placed and Closed will not be checked. They can be checked based on the status of the
order. Closed orders may not have any further items added. Once you are satisfied save the
header and enter the details.
You can load the stock order with sold items sourced from the supplier by clicking the From
Sales button. The pick option doesn't prevent the selection of items more than once. It adds
items to the order one at a time. So, if more than one is being ordered, you need to edit the line
after it has been added.

Once the header has been created add lines to the order.

· The value of the stock order is based on the buy price. Add tax to buy price is unchecked by

·
·
·
·

default. If you check it, when the inventory is updated, buy price is the price entered, plus tax.
From then on it shows as inclusive of sales tax when you order that item again. In Retail
Business sales the buy price is inclusive of tax. If you are ordering an existing stock item leave
the box unchecked or tax will be added to the price. Which already includes tax. Check the box
if the order is to an overseas supplier.
If ordering from your existing inventory leave Add tax to Buy price unchecked. Existing
inventory items include G.S.T in their buy price.
The stock code can be obtained from the inventory, or you can enter a new one. If you enter a
new code the description field displays "New stock item". Enter a description of the item. If this
is a new item an inventory item is created when you save the line.
If the item has a supplier stock code that is placed in the Stock code field instead of either the
bar code or code/PLU. Supplier stock code (from the inventory) is used as the item code in the
order if it differs from the stock code.
If this is a new item enter the description. Other wise the description is that of the selected
stock item.

· Enter the Buy price per unit. This is required to calculate the total value of the order. It does
not appear on the order form when it is sent.

· Enter the Number Ordered. If you are making up an order that includes returns, and this line
·

is a return, then enter a minus value.
If you are recording receipt of items enter the Number provided. For returns this should be
zero. If you are entering the order after you have sold the items the stock level may be
negative. In practice you want it to be zero, or less than the total ordered for that item. For
example 6 items may have been delivered, you sold 4 and the stock level is -4. In that case
make sure the box Zero negative stock level and add balance (if any) is checked. The
stock level will be set at 2 when you enter 6 as being provided. Uncheck the box if you fulfill
any orders prior to selling the items. To activate this option you must fulfill the order item
manually.

You can create a supplier invoice, add items to an existing invoice, and pay for the order from the
stock order form. To do so click the Invoice button. You may not create another invoice if one
has already been created for the order.
To email a stock order to a supplier click the Email button. The current stock order is placed in
the Attachments list. The supplier must have an email address.
Order fulfillment.
You can fulfill the entire order by clicking fulfilled. The number provided equals the number
ordered. If the order is not, already, marked as placed that is done, and the order is closed. The
inventory is also updated and the items provided are added to the number of items in stock.
Alternatively click Selected in the fulfillment panel. The following form actives:

If all items have been fulfilled click All. Or enter each field under Provided if the amount is less.
This list only displays items that have not been fulfilled.

Stock control
Use this form to configure the stock sub-system.

· The unique code is required.
· Description is optional - put something in there if you are running more than one company.
· There does not have to be a stock control record. However to control certain features whether stock codes are auto-generated, the first sale slip number to use and the first stock
order number to use - you must set up a stock control record.
· If you want the stock maintenance form to generate stock codes check the box "Auto add
code/PLU numbers" and enter the first number to use. WARNING - make sure the first code
is unlikely to duplicate the first four numbers of any bar code and that it is, at least, 4 characters
in length. If you use a label scale to generate codes make sure the number is 6 characters in
length.
· When entering bar codes the best idea is to use the supplier-provided bar code. This makes it
more likely the code is a valid one, and that it can be read off a label using a scanner. If you

·
·

must create your own bar codes then enter 12 characters only into the bar code field. When
you do that a button labeled "EAN13 check digit" becomes visible under the Supplier code
field in Stock Maintenance. Click the button and the check digit is added to the code you keyed
in. This check digit is required for a scanner to recognise the code is a genuine EAN13 bar
code.
Last stock order and Last sales slip no slip fields are optional. Once you have entered
numbers here only change them if you are sure the new numbers will not duplicate any existing
ones.
"Use book labels" check the box if you are running a book shop. This ensures the correct
fields are visible in the stock maintenance form and that the correct supplier list is available to
load and update the price lists. If it is not checked suppliers are assumed to be trade.

· If you enter customer numbers against the relevant supplier your customer number is placed
on stock orders. To complete these fields create the required suppliers.
Last stock order is used when a new stock order is created. To identify orders by year create an
order number that looks something like the following - 200700000. The same applies to the sales
slip number.
Sales slip number is required. You can leave it at 0. When you make sales from the POS the
number is incremented.

Stock returns
Stock returns may be made directly into the inventory. As a minus value.
When entering returns into stock orders you can mix returns with a normal order, or create an
order that consists of returns only.
Saving the order line results in the inventory level being adjusted by the amount being returned.
Returns are entered into the order line as a negative Number on order.
In the POS enter returns as credit sales or refunds.

Price labels
You can produce price labels for three label printers - Brother QL series, Dymo Labelwriter and
the Zebra LP series.
For the Brother the following labels are available:
· 29mm by 30.5mm (DK-22210)
· 62mm by 30.5mm (DK-22205)
· 51mm by 102MM - weight and quantity labels (DK11240). With, or without, bar codes.
These fit all the QL500 series P-Touch printers

For the Zebra the following labels are available:
· 40mm by 28mm (L11384)
· 61mm by 36mm (L10005)
· 30mm by28mm (*3) (GC420 series)
For the Dymo 400- series Labelwriter:
· 32mm * 57mm (#11354)
· 36mm * 89mm (#99012)
· 54mm by 102mm - weight and quantity labels (#99014). With, or without, bar codes.
The codes in brackets are what to look for when purchasing label rolls.
To print price labels make sure you have the correct stock item displaying in the Stock
Management form.
There are six label printing options:
1. On an A4 sheet, in multiples of three. Check the Generate price label box. Carry out the
required actions, then click Labels (A4). The label format is Avery code L7157.
2. Labels (single or multiple) with bar codes.
3. Labels (single or multiple) without bar codes.
4. Quantity labels (single and multiple) with bar codes
5. Weight labels (single and multiple) without bar codes.
6. Display labels – with barcodes, units and price. These are to be placed on the front of shelves
Both quantity and weight labels include "Manufactured on" and "Expires by" dates.
Select the printer from the drop down list.
Click the Labels button with the bar code on it. The following form activates:

The sizes provided allows you to produce both product and display labels. Product labels can be
placed directly onto the item if your price differs from RRP. Or the item has no bar code Display
labels can be put onto the shelf edges.

· Click Select printer to update the default printer setting. The example above has been
switched to a Brother QL-500.
· Check the printer the labels are for.
· Check the button for the relevant sized label.
· To print a single label click Print.
· To preview, and possibly print multiple labels, click Preview.
If you select Brother QL-series, and 62mm * 30.5mm size, clicking Preview results in the
following form activating:

Be aware the item must have a valid bar code.
"0000000000000".

If it doesn't the "bar code" will be

Weight and Quantity labels
Weight and quantity labels enable you to print labels with the date the item was manufactured
and the date it expires.
You can also include the long description if the item has one. Bar codes are not required for
weighing items. Check the box "Do not print bar codes" if the item doesn't have a bar code. If
you don't checked that an invalid "000000000000" bar code will be printed.

Weight Labels

· Select the printer to use. The label uses the default printer. So you will need to switch to the
correct label printer.
· Select the label type. NOTE - make sure the printer is preloaded with the correct label. In the
case of the Brother QL the printer will not print anything if there is not match between the labels
loaded and the label size shown.
· Decide whether you want the price to show n the label.
· Decide whether you wish to print a long description.
· Select the date the item was packed on.
· Select the "Best before" date.
· Enter the total weight - off the scale.

Once ready the form should appear something like the following:

The label appears as follows:

Quantity labels
Quantity labels differ from weight labels in three respects:
1. There must be a bar code
2. Total price is based on the number of items.
3. Packed and best before dates are optional.

A4 labels - Avery code L7157
To print these labels first generate the required number of labels to print for each stock item.
Check the Generate price label box in Stock Management
The following form activates:

Each item must be printed in multiples of 3. The maximum per page is 33.
When you have accumulated enough items (minimum of 33 to avoid wasting paper) click the
Labels (A4) button.
The following form activates:

If the item has a bar code that is included on the labels. If it doesn't a bar code is printed, but with
a value of "0000000000000"

Price labels - singles.
There are two options for producing single price labels.
· With bar codes
· Without bar codes.
To produce them you use the same form.
Click either Labels (with the bar code) to produce labels with bar codes, or Labels (Price) for
labels without bar codes.
The following form activates:

· Select the printer from the drop down list. This list always displays the default printer on the
first line.
· Click Select printer to update the default printer setting. The example above has been
switched to a Brother QL-500.
· Check the printer the labels are for.
· Check the button for the relevant sized label.
· To print a single label click Print.
· To preview, and possibly print multiple labels, click Preview.
If you select Brother QL-series and 62mm * 30.5mm clicking Preview results in the following form
activating:

If you preview a label it is possible to print more than one. Click the printer icon with the green
wrench on it. Reselect the correct printer and the number of copies you want.

Item expiration
To track stock ageing you need to use supplier orders. Use item ageing when you need to know
when an item must be removed from the shelves and you may wish to place on special.
Because stock tends to be delivered in "batches" you need to record the stock batch when the
items are delivered. Ageing is based on when the items were manufactured/shipped/arrived
record the manufactured date and the date the stock needs to be sold by.
This means that, if identical stock items are delivered for a single order, but at different times,
they will be in different batches. To deal with that you need to include an order line for each
batch. If you are going to use supplier orders in this manner it is a good idea to enter the stock
details as the items are delivered.
Which means, if you have sent out the order, you may need to add lines if the items are delivered
in multiple batches. That is, create additional order lines after you record the first batch delivery.
You can then enter the batch details.

· Create the stock order as usual.
· Create the order line(s) for the items ordered.
· To enter batch details click "Order batch":

The batch number can be a number/code provided by your supplier or a number/code you use
yourself.
Once the batch details have been entered you may query the expiry date for the relevant items by
clicking the "Batch details" button to the right of the item list in Stock Management. This button
is only visible if the item has any batches set up.

The following form displays:

To print all items due to expire between certain dates click the "Batch report" button on the
Stock Management form. A more detailed report can be obtained from the Sales Report - Stock
expiration option

Stock requisitions
Use stock requisitions when stock is removed from the inventory for internal purposes but not
necessarily sold. For example if you run a service business and hold stock in vans or meed to
take some offsite for demo purposes. Using requisitions enables you to know the actual stock
levels available for sale
The requisitions form is as follows:

Requisition items must exist in the inventory.

· To add a new requisition click Add.
· The number is created automatically.
· Enter the name of the person requisitioning the stock. Depending on your internal policies they
may need to sign the requisition form.
· Enter the reason.
· Enter the date.
· If stock is to be drawn down check Draw down stock. If you leave this unchecked the actual
level will not be accurate once any of the items requisitioned have been used.
· Click Save. Details become visible.
To enter details:

· Click Add.
· Select/enter the stock item's code or bar code.

· Enter the quantity being requisitioned.
· Click Save.
· If written authorization is required click Print and sign the form.

Stock packages
If you have activated the items options buttons in POS Settings then you cannot create any
packages. You can either use packages or options.
Stock packages are stock items that are made up of other stock items. The total price of ALL
items in the package makes up the price of the package
For example, if you sell a set of gear that is always bundled. Or assemble an item from other
stock items.
In that case you will want the stock level of both the stock package, and the items that make it up,
to be drawn down on sale. This is what a stock package allows you to do.
Setting up stock packages:
Set up packages in Stock Management Before you start make sure all the items that make up
the package are set up.
Existing stock items can be converted into packages by clicking the button "Package items". If
the item already is a package the items that make it up appear in the list.
· Click "Add" to add a new stock item.
· Enter the stock code, and description. There is no need to enter buy, trade or retail price.
These are updated as items are added to or removed from the package.
The box Is a package is checked once the package has been set up.

Click Save when finished. Then click Package items. The following form activates:

Add as many items/components as required. You can include more than one unit of any
component. You may not include the package item itself as a component.
When a package is on sale, or is a special, the same rules apply to it as apply to normal stock
items.
To help you find existing packages so you can change their components when required click the
Packages button in the Lists group. If the price of and component change you need to delete the
component from the relevant packages and add it again.
Selling Stock Packages through Retail Business POS
When selling the package through the POS select the package code only. When you do so the
following form activates.

You may print the component list to ensure the customer knows exactly what they are getting.
The package description, its price and the package items appear on the receipt. If the
components are correct click Confirm. If you click Cancel the package is removed from the list.
When a stock package has been added to the docket the POS appears something like the
following.

Notice that only the first line has a price.
Components of packages can be added to the docket as independent items. In that case the
quantity changes as more are added.
Packages and options
· You can switch packages to option by enabling options in POS Settings.
· To do so either create the items as non-stock and with no retail price.
· Or delete the price from the package item so that the package components add their price to
the docket as you select them
· Add those to options as usual.
· When the options selection form activates. In this case you need to click the buttons as many
times as there are items in the "package".
· The cashier then selects the items as usual.
The following example shows the options setting for a security system. The options match the
items in the example package above. But this time the "package" has no price. Only the
components do.

The "package" item now has no retail price. It can be set as a non-stock item if there is no need
to track how many have been sold.
When the package has been added to the POS docket the option prompt displays as well.

The cashier adds the requested item option to the docket. As above.
Changing package prices
If an item is part of a package, and you change its retail price, that change results in the total
package price being changed. If you don't want the package price to change at the same time as
an item's price is changed: 1. Select the package of the item you changed. 2. Go to Package
Maintenance.
· Select the item with the new price.
· Change that back to the old price - retail price field.
· The total package price will now be the same as it was before you changed the item's price.
If you wish to update the package to mirror the actual item prices - 1. Select each item in Stock
Management. 2. Click Edit. 3. Click Save.
The package price changes without the need to actually change the item's prices. So long as you
click Edit and then Save.

Replenishing stock
You can automatically select stock for replenishment.
Stock items you want to auto replenish must be allocated to a specific supplier. If the supplier
field in stock maintenance is blank the item cannot be included in any order.
1. If you want to set up a low stock level warning you can do so for each item you think it is
required for. In the stock maintenance form, click the Restock items tab. And enter the values
required.
· To enable auto replenishing check the Auto replenish on box.
· Enter the "Minimum stock level" that will trigger the warning and add the item to an order when
you run Stock replenishment.
· Enter the "Maximum order level" to set a default number of items that are ordered when the
replenishment order is generated.
· The "warning" takes the form of a red highlight on stock lists, the Stock Management form
stock list and a red frame around the item button for any such item.

In the above example the item is highlighted as soon as the stock level reaches 5. 10 items will
be ordered by default.
The Stock Management form appears as follows if any items are less than the minimum stock
level set.

2. Alternatively you can set up replenishment rules that can be applied to all items that have been
linked to a certain supplier. In that case click Replenish Stock in Stock Management, then the
"Replenishment rules" button. And select the supplier.

In the above example there is one, active, order for MasterTrade. It has been generated from the
replenishment process. if you generate any manually they will also be in the list.

All their items appear in the list below their name. Enabling this allows you to generate supplier
orders when you need to. All the items the minimum stock level applies to are added to the order
automatically.

· Enter the value that will trigger a stock order creation - Minimum stock level.
· Set the Maximum order level. That level will be the default order level on each order. You can
review orders and change that level if you wish
· Enter the value that will appear, by default, as the number of items being ordered.
· If you want the set rule to apply to all items for that supplier check "Apply to all items".
· Click Save.

You can turn auto replenish off for the selected supplier by unchecking the box "Auto replenish
on".
Once you have set up the auto replenish parameters you can generate orders for items when the
level reaches, or is less than, the defined minimum stock level.
If you have also set up order replenishment for individual items the auto replenish values over
ride those values.
The auto replenish process can be run from Stock Management -> Replenish stock.

Any open orders for the supplier are listed. If you click the Replenish button new lines are added
to the selected open order for items that are due for replenishment. To create a new order
Review the orders and close them. If none are listed clicking Replenish results in the creation of
a new order. Once the process has been run the new order displays and may then be reviewed.
Warning - until the stock level of auto replenish items is above the auto replenish level clicking
Replenish keeps adding those items to the selected order as separate lines.
You may review the order and change ordered quantities or delete any lines that were created.
To make sure the order is complete add the supplier, and your customer code, to the stock control
record. That is, if you're going to email the order to the supplier.
When a stock order is generated the stock inquiry page, and the inventory maintenance form,
display the number of items on order. To keep this total accurate use stock orders to record order
fulfilment. When you update the number provided the number on order is decreased by the
number provided.
In the POS, if you use the item buttons, the buttons of items that are at, or below, replacement
level, are ringed in red. As follows

On the stock selection list they are highlighted red as well.
You can print a list of all all such items by clicking the "Reorder items" button. The list can be
printed as receipt or A4 width.
You can review orders in Supplier orders

Item sales settings
Use sales setting to configure the way the stock item (selected in Stock Management) displays,
and behaves, on the POS.
If you wish to be reminded of something when selling an item you can set the Extras Prompt on.
For example if the item needs batteries added a prompt can come up when the item is selected
that reminds you of that. Or you can have notice come up that the item is at the end of the line.
Or that delivery is free if they buy over X number of items.
You can also set up individual item sales specials. If you wish to set up sales for a large number
of items it is better to have stock configured into lines and groups. Doing this makes it much
easier to set up sales, and have them finish when required.
Individual item specials need to be turned on, and will then stop when the Finishes date is
reached. Sale specials can be set up as either a flat amount or a percentage decrease.
To activate select the correct stock item and click the Sales items details tab in Stock
maintenance.

Extras Prompt
· To turn on the extras prompt check the Extras prompt box. The following form appears.

If there is already an extra prompt, and you want to edit it, uncheck, then recheck the Extras
prompt box.

· Enter the required text into the Text to display field. This message displays if extras prompt is
on for the item and you are adding it to the docket in the POS. In that case the POS will look
like this.
· Select the date you want the prompt to be active to.

If you activate item details for an item the extras prompt is deactivated.

Item special
· To set a special for the item check the On special box in Stock Maintenance "Item sales
details" tab

· Enter either a Discount (%) or Flat discount ($). You can have one or the other, not both.
· Enter the date the special is to apply from.
· Then the date the special finishes. Specials/sales can also be set up using groups or store
sales.
· If you wish to prevent cashiers providing one-off discounts for any items enter "0.01" into the
"Discount limit (0 is none)" field. You can also limit cashiers ability to apply one-off discounts
by entering a similar value into their profile.
· The Turn on price calculation option is now redundant. If you click "Change price" on the
POS all prices for the item display and can be over ridden. Or one selected by clicking the
relevant button.
· You can set the POS to deal with the item in a specific manner. For example if you use
checkout scales, and the item is to be weighed, check the button "Weigh item". If you want the
item included on an order (in addition to the receipt) check the relevant button. Those four
options are of particular use for takeaways and cafes. The default is "Normal".
Note - you need to turn specials off once the specials period has finished. To help you do this a
list of items currently on special can be displayed from the inventory form. You can then select
the item and turn specials off.

Promotions
Four types of promotion can be arranged:

·
·
·
·

Store-wide and group sales
Multi-item discounts
Volume discounts.
Stock item specials

In addition you may arrange item and docket discounts.
percentage or a fixed dollar value.

Which can be done based on a

Store wide sales are set up from POS settings.
Group sales are set up from stock line maintenance. Accessed from Stock Management

Sales - store and group
Set up store wide sales from the POS settings form. Click the button "Activate store sale".
The following form activates:

· Select the dates the sale is to start and stop on.
· Enter the percentage discount that will apply.
· Enter a description for the sale. This displays at the top of the POS while the sale is running.
· When ready to run check the box "Check to activate sale between the selected dates". You
must check this box to run the sale.

Volume discounts - price breaks
If an item has been set up for price breaks it may not set it up for multi-item discounting as well.
Only one type of discount can be used at a time for any item. That means, if you wish to set up
price breaks, and the item is currently part of a multi-item discount set you need to remove it from
the multi-item list.
All items can be set up for price breaks. To do so click Price breaks on stock management when
the correct item displays.
The following form activates:

You can set up a maximum of three discount levels. To do so change the number in How many
price breaks?
To allocate three price breaks the form appears as follows:

Set the number from which the discount applies by changing the values in Second break and
Third break fields. The break is defined as one above the number displayed. So 1+ means 2 up
to the next break, 4+ means 5 and greater. The first break cuts off at 3. The second at 6.
With the full range set the form appears as follows:

When an item has price breaks set they are applied automatically in the POS. The POS switches
to manual mode and waits for you to apply the number of units.
When price breaks have already been set for an item, the following form activates when you click
Price breaks. You may change existing prices, or delete the price break.

Price breaks are based on unit price, not a percentage discount. That means, for example, if you
wish to give a 10 percent discount for quantities between 2 and 5 units you need to calculate the
unit price AFTER the 10 percent has been taken out. So a $6.00 single item would become
$5.40. If 20 percent then the same item is $4.80. Those discounted prices are the figures you
need to enter into the relevant fields.
The level of discount doesn't appear as a discounted level on the docket. However it will be
shown on the receipt as an amount saved.

Item details (styles, etc)
Retail Business allows you to set up multiple items for stock. That is, a stock item has one stock
code and bar code and a single price, but multiple items. Eg. mens Armani slacks may have 1.
short leg, 2. medium leg and 3. long leg. Or you can set up stock items based on colour and
have styles for each colour: eg. Mens Armani black slacks - short leg, medium leg, long leg. This
enables you to keep track of what colours sell the best. To do the later you must make sure the
stock detail item has a unique bar code or stock code. And preferably has a bar code as well as a
stock code.
Items details are where you often select a certain number of an item that varies in only one way
from the "parent". For example a set of slacks, blouses, tyres, etc that differ on something other
than price. If the difference is on price as well as description then use the options buttons.
Item details can be used to arrange sales of second hand items. In that case each item on the
details list can have a different price.
To set up multiple styles first go to the POS Settings form (System settings -> POS Settings) and
check the "Enable multi-item selection - (styles, colours, prices)" box. As follows:

Once you have done so the stock management form looks something like the following:

Note that there is another button active at the middle right - Item details. And one item is shown
in a light blue line. That is the item with styles set up.
When setting up a stock item for which you intend to include item styles don't include a value for
No. in stock. This is updated as you enter the number of items for each item's details. You do
need to enter a buy and retail price.
Once you have entered the details for the primary stock item click the Item details button. The
following form is activated:

· To add an item click Add.
· To edit an existing item click Edit.
· To record the return of an item click Return. If an item has been sold click Sold. These two
buttons are only required if you need to make manual adjustments to the inventory level.
Generally they should be ignored.
· In the above example the only difference between the lines is the colour.
When you click Add the following form activates. Note that the description of the main stock item
is used. You should modify that to match the description you want to be printed on the receipt.
This description is the one on the sale docket when it is printed. It is also the one used on stock
orders and invoices.

· Retail price defaults to the same as the retail price of the parent item. You can change this if
you wish. In that case this price is the one used when making sales. If you intend to have all
details with differing prices then use the options buttons instead. When editing the item on the
POS the price of the parent is used. Not that of the detail item.
· You can enter another buy price if there is one. For stock take purposes the main stock item's
buy price is used. So, if there are variations in buy prices for detailed items the main stock
item's buy price should be an average of the buy prices for all detail items. It is therefore
simpler to use details when the buy price is the same for details and parent.
· The item code defaults to the same code as the main item. For simplicity sake it is a good idea
to leave it unchanged. This is the code that prints on the price labels when you generate them
from this form. Doing it this way enables you to use a common bar code and still identify the
correct style item.
· You can, if you wish, have a unique bar code for each detail item. Doing so allows you to
select the item using a scanner. This can speed things up if you have a large number of
detailed items for any stock.
· Date of purchase defaults to the same day as you create the details.
· Enter the stock level of this detailed item. The value entered here is added to the total stock
level of the parent item.
Once details have been created for a stock item another form is activated when the main stock
item is selected for sale.

When an item is selected the stock level for the detail and main item are both drawn down. If the
sale is canceled, or the item returned, you need to select the detail item to reverse the sale. The
details list pops up every time you complete a transaction for an item that has them. As follows:

In this case the item is being cleared from the POS docket.
· Select the detail item that is being voided.
· Click "Return item".
· Click "Return to POS".
If you find you regularly have to keep re-selecting items then consider switching to using stock
options buttons instead. In that case the description of the item selected doesn't change. But
you need to enter an individual stock item entry for each "option".

Sales receipts - formatting
You may set up sales receipts to match your requirements. Within certain limitations, as follows:
If you use both 57mm and 80mm receipt printers you need to set the format for each.
1. The text is always centered.
2. Other than the company name, you can't change the size of the text.
3. Certain text has to be printed - date and time, receipt number, G.S.T. number, "**** tax invoice
*****", and "You were served by....".
You can add:
1. A fuller company header. For example a description of the company, phone number (the
default receipt already has this), address, email/website, etc. If the top text block has nothing in it
the user defined receipt will not print.
2. Notes/conditions of sale/refunds/returns policy, etc.
The more you add the longer the receipt becomes. But that's up to you.

To change the default settings you must be logged on with the highest level access.
On the Retail Business main form click POS Settings then Receipt layouts. The following form
displays:

Depending on the width of the receipts you use click the relevant button. The only difference
between the forms activated is the width of the receipt.
You can change the format of either as one cashier may use a 60mm roll, and another an 80mm.

For each paper width two receipt formats can be set up. If you set up the user defined one that is
the one that will print. To return to the standard receipt clear both the address and memo fields
and click Accept.
An example of a user defined receipts layout is as follows:

· To set up a logo on sales receipts follow the instructions below.
· Changes to Company control details change the relevant sections of both receipt types.
· You can, safely, enter up to five lines in the top field. Any more than that and the contents will
over print the date and time field on the receipt.
· The User defined settings apply to both the top and bottom fields. If you enter notes, in non
bold format, and then switch to bold and/or italic the notes may print with alternate lines having
only one word in them. If you want to print these fields in bold then switch them to bold before
you start typing anything.
· To review the layout you need to have completed at least one sale. The review facility allows
you to change your mind about things before printing an actual receipt. If you made any
changes click Accept before running a review.
5. Styles can be a combination of bold, italics and underline.
Setting up a receipts logo
·
·
·
·
·
·
·
·
·

Using your existing logo (if you have one) - open Windows Paint.
Open the file.
Save it as logoss.bmp in the folder C:\PSL\Database\images. Note the 'ss'. This stands for
sales slip. You may not be able to use the logo that you may have already loaded for the
company if it is too large for the receipts.
Resize the file. Select Image → Stretch/Skew You may be able to get away with decreasing
it by 50% horizontally and vertically.
Save the file.
Open the settings menu in Retail Business. Select any one of the format sizes.
Click the Logo button. Load the file and then Confirm.
It should appear on the example forms.
If it doesn't appear to fit you will need to go back to Paint and fiddle around a bit more with
the size. From now on, when working on the logo in Paint, make sure you open the file
logoss.bmp in the C:\PSL\Database\images folder of the PC the base system was installed
on..

Connecting cash drawers and receipt printers
Retail Business has no special drivers for dealing with cash drawers and receipts printers. As a
result it should work with just about any cash drawer and printer combination. But you do need to
be aware of a few things.
The software has been designed to work with the printer's Windows drivers. That means you
need to install the drivers that come with the printer. If you are switching from another POS it is
possible that none were installed as the POS communicates directly to the printer. To find out if
that is the case click Start -> Printers and faxes. If your receipt printer is not there you need to
obtain the Windows drivers for it. Generally they are available from the manufacturer's website.

To get your cash drawer to open make sure it can connect to the POS. There are four ways the
connection is established:
1. By using a 'Y' cable. A single cable that splits to connect to both the cash drawer and printer.
2. From the cash drawer to the printer. The cash drawer is connected to the PC and the printer to
the cash drawer. Some configuration of the cash drawer may be required. Read the manual that
came with it.
3. From the printer to the cash drawer. The printer is connected directly to the PC. The cash
drawer to the printer.
4. By using a drawer kicker. The kicker is attached to a serial port that differs from that of the
printer. It must be able to open using the default Epson drawer open commands.
Make sure the receipt printer's driver is using the correct port. Generally, if the printer is
connected using a USB connection, there is no need to specify the port.
If you are switching from another POS system it is possible that the printer/drawer configuration is
not factory default. You may need to obtain a manual to find out how to reset to factory default.
One common problem is that the baud rate (communication speed) is not correct. In most cases it
should be either 9600 or 19200 baud. You may need to test with the preview function. If you get
'?????' or other characters that may be the cause of the problem. In some cases you may need
to change dip switch settings on either the printer or the drawer. Again you need to obtain the
manuals if you don't have them.
The cash receipts have been designed to work with both 60mm and 80mm receipt rolls. To test
that your receipt printer prints everything create a single sales receipt and print it. Once the sale
has been completed you can review it to test further. If the receipt is cut off at either the left or
right you may need to change the printer's form margins. To do that click Start -> Printers and
faxes. Right click the receipt printer and select Properties. Check the right and left margin
settings. If there are any.
Warning - there are some cheap serial receipt printers out there. They can only be connected to
the COM port. This will cause a problem because Windows isn't very friendly when it comes to
dealing with the COM port any more. The connection will often be dropped. It is better to use a
USB-based printer.

LCD/LED Customer displays
If you have a second monitor it can be used as a customer display.
1. Connect it to the required HDMI or VGA connection.
2. Make sure Windows recognises it is present. Go to Control Panel->Screen resolution. There
should be two screens displayed there. Make sure the correct one is designated as the primary
monitor. That is the one the Retail Business will display on.
3. Go to POS settings and check the box "Activate second monitor (if present) as customer
display"

If that is all you do the second monitor will look something like this:

The exact layout of the display depends on the size, and shape, of the screen.
You can add information - for example adverts and specials - to the display. Go to the Customer
Facing tab in POS Settings

There are two fields you can use to add features to the customer monitor
· Animated pictures
· Static picture.
The animated pictures display at the bottom half of the screen. The "slide show" consists of ALL
image files in the selected folder. So you may want to be careful how many files are there. And
remove any unwanted ones as soon as possible.
The static picture displays at the right hand side of the screen.
You may need to experiment with sizes to get the pictures to display properly as their actual size
is set by the screen size.
To select an animated display on a cashier lanes make sure that all lanes have the same named
folder set up and the files to be used must also be identical. The easiest way to do that is to set
them up on the base system first. Make sure everything is as you expect. Then create the same
folders on the lane's computers and copy the files.

With the images set up the customer display looks like the following:

Using/installing customer pole displays
Your customer pole display must be compatible with the Epson DM series. This may require that
you change the factory dip switch settings.
To install the customer display:
1. Download the Epson OPOS-Adk drivers from here:
https://download.epson-biz.com/modules/pos/index.php?page=prod&pcat=9&scat=38&pid=64
Paste the above into your web browser's address line.
2. Select the OPOS ADK and accept the license agreement.
3. Download the file V267ER9.exe (or whichever is the latest) to your PC. Copy it to the PCs that
are going to use pole displays.
4. Double click the file to install the driver. Install using the defaults. Retail Business needs to find
a file that is installed and it must be in the default location.
5. From the Start menu select OPOS -> Setup OPOS.
6. Highlight LineDisplay as below (this applies if installing either the Digipos or Posiflex displays not the HP LD220):

7. Right click LineDisplay and select Add New Device. The following form activates:

Select Next and accept all the defaults. Do not change anything. Give the new device the logical
device name "LineDisplay"
The best idea is to select DM110 as all later models are also compatible with that.
8. Don't connect the pole displays until you have checked the following:
a. Digipos WD series - open the dip switch cover under the display at the rear. Check
the switches are set as follows: SW1 - off, SW2 - on, SW3 - on. Down is on, up is off. Lay the
display face down.
The switches are located as follows:

It is possible that the display already has the required settings.
b. Posiflex PD21 series - open the dip switch cover at the back of the display unit. Check
the following: SW1 - off, SW2 - off.
The switches are located as follows:

If you are using an Epson DM series display there is no need to make any changes. But you
must make sure you install the Epson DM displays as stand alone.
If using any other brand of pole display you need to obtain the user manual and find out how to
set it to Epson compatible display.
6. IF the pole display uses a serial (not USB) connection use a USB to serial converter cable.
This is required because Windows allocates logical com ports. And they don't always match with
the actual serial port on the back of your PC. Install the driver for the converter cable and assign
COM1 to the port it is allocated to. As follows:

To activate this form select Control Panel -> System -> Hardware -> Device manager
First disable the default COM1. To do so select Communications Port (COM1) and right click
the mouse. Select Disable. In the above example Enable displays because the port is already
disabled.
Accept the option to restart your PC.
Once the PC has restarted reactivate the Device Manager form. Select the USB to Serial port,
right click, select Properties -> Port Settings -> Advanced. Select COM Port Number COM1. You
may be warned it is in use. Ignore it. Click Ok. Then Ok to exit the device manager. Restart
your computer.

Warning. It is possible you may need to do this every time you restart your computer. Windows
may reassign the logical COM1 to another port.
Now connect your pole display.
To check that your pole display is running properly carry out a health check. As follows:

To do so click Start Menu -> OPOS -> Select devices then Line Display.
CheckHealth Interactive...

Select Tools ->

Click start. If successful the phrase "Interactive HCheck!! DeviceName=DM-D110" or something
similar should appear on the pole display.
Retail Business also carries out a health check when it starts up. If "Retail Business/POS
Welcome" doesn't appear on the pole display then Windows has reassigned COM1. You will
have to go through the above process to reconnect.

Pole displays and com ports
Most pole displays are serial. Which means you may have connected it to the serial port at the
back of your PC. This may cause problems as Windows does not always allocate the logical
COM1 to the physical serial connection. If your pole display fails to display "Retail Business/POS
Welcome" when Retail Business starts up you may have this problem. The problem is that
Windows support for the serial port is being run down.
To resolve it buy a USB to serial converter and install it. Or buy a USB pole display. It should
come with a utility that acts as a bridge between the serial port and the USB port. Then follow the
instructions below:
1. Select Control Panel (left click Start) -> System -> Hardware -> Device Manager. Disable the
"Communications Port (COM1)" and restart your PC. To disable the port right click it and select
Disable. Ignore the warning.
2. Select as above and allocate COM1 to the USB to Serial Comm Port (COM3) by right clicking
the port and selecting Properties -> Port Settings -> Advanced. This whether you are using a PC
that has a physical COM port or not. The pole display must be connected to the COM1 port. If
you have installed a checkout scale that can be attached to any other port as part of the set up.

3. Leave all the settings as you find them. Except for COM Port Number. Change that to COM1.
You may get a warning. Ignore it.
As follows:

There is no need to restart your PC after you have made this change. Now run the interactive
health check using the OPOS driver. As follows:

To do so click Start Menu -> OPOS -> Select devices then Line Display.
CheckHealth Interactive...

Select Tools ->

Click start. If successful the phrase "Interactive HCheck!! DeviceName=DM-D110" or something
similar should appear on the pole display.
Start up the OPOS ADK tools. Select the line display. Right click and select Add New LDN. In
the field at the bottom enter the word "LineDisplay". Click Continue, then cancel. This is the
name the software uses to identify the device.

Retail Business POS - screen resolution
You may need to change the screen's display resolution to get the full POS form to display. Use
Control Panel -> Display and change the resolution until it fits. If you still can't get it to fit then the
video card you have does not allow the required resolution. If using a 15 inch screen the
resolution needs to be 1280 by 1024. If your monitor does not allow that you may need to get
another, higher resolution, video card.

Setting up the POS buttons
Create stock items before attempting to create POS menu buttons (you can set them up as
options or packages if you wish to track inventory levels in detail). It is optional to use stock lines.
However stock lines, if used, allow you to obtain useful summary reports by line.
To make sure menus, and their associated buttons, are easy to use it is a good idea to group
items that are purchased regularly with the menus on the first 15 menu buttons. This is especially
important if you have a large number of items you intend to put on the buttons. If they have bar
codes there is no need to. Unless they need to have options. In which case include them.
If items are often purchased together it is a good idea to group them together under the same
menu. Even if some of them may be on other menus.
If the menu buttons have not been set up there will be blank buttons on the POS if the buttons
have been enabled.
To set up the menu buttons go to "POS setting"->"POS menu buttons".

If the Hospitality module is activated.

To create menu buttons you must create at least one menu so that there is at least one button in
the 'Select menu' list.
Menus are set up for whichever menu is currently selected on that list.
The following describes linking items to POS menu buttons.

Setting up menu buttons
· You must first provide a menu button with a caption. Once you have done so the item buttons
are enabled.

· The maximum number of menus is 60. 15 are visible at a time.
· To create a menu button double click it. The following form activates:

· Enter the caption text. If you want to include additional text - eg Chinese characters - then
enter them into the "Other characters" field. Be aware the menu buttons can't be made any
larger so be cautious of adding too much text.
· Click "Update caption" to set the text.
· To change the button's colour click "Button colour". The following form activates

· Select from the existing colours or click "Define customer colours" to set up a colour you
prefer that isn't in the palette.
· Click "Ok" and the button updates.
· To change the caption text click "Text style". The following form activates.

· You can select different font types, styles and sizes. Click "Ok" and the button is updated.
· You can also change the text colour. The default colour is black. But you need a much lighter
colour on dark buttons. Click "Text color". The colour selection dialogue activates.

Setting up the item buttons
1. Make sure you have set up/selected the correct menu button.
2. Drag and drop an existing stock item to an empty item button.
3. Stock items can be allocated to multiple menus. This allows you to put them in places where
they are likely to be sold with related items.
4. The maximum number of buttons for any one menu is 120. If the Hospitality module is
installed the maximum number is 96.
4. Double-click the button. The following form activates

· The button label already exists. You can change it if you like. NOT recommended. If you do it
will not match the description on the docket, orders, or receipts.
· If the item description is long, you are using additional descriptions, or want to add a picture
you may wish to enlarge the button. The description length is limited to 50 characters.
· If you want to enlarge the button make sure the button immediately to the right of the selected
button is clear.
· If you want to double height it make sure the buttons immediately under it and diagonally to the
right is also clear.
· The example above is double width but single height.
To include pictures on buttons:
· Make sure you have created a local folder for all images. They must not be held on a central
server as loading them across a network will slow things down. A lot. Depending on how many
need to be loaded.
· First make/load the images on the base system. Then copy them to a folder C:\PSL\images on
each lane. They must be either JPEG (.jpg) or BMP (.bmp) files. You may need to "tweek" their
sizes. It is better to decrease their size. If you increase it their appearance is likely to suffer a

loss of resolution.
· Resize, and test their appearance on the button settings of the base system, BEFORE you
copy them to the cashier lanes
· Their location MUST be the same on all lanes. That is, use the same, local, folder name on all
lanes.
· Click "Attach picture". The following form displays.
· Scroll through the list until you find the picture you want to attach.

· Click "Open".
· The button will now have a picture on it. Note - the text still displays at the top. So it is a good
idea to make sure the picture is small enough to allow that. Especially if you have pictures that
may be open to interpretation or are similar between items.

· The POS will look something like the following when the menu for the relevant items has been
selected.

· If you wish to duplicate the format of an existing button
1. Place an item on a blank button. You can also replace existing formats
2. Select the button you want to copy the format of.
3. Click "Copy format"

4. Left click the button you want to copy the format of and drag to the new button.
· If you wish to copy an existing button to somewhere else on the selected menu.
1. Click "Copy button"
2. Left click the button you want to copy. It must have a item attached.
3. Drag to the button you want to copy to.

· To clear a button select the button and click "Clear button".
· To refine your list you can enter a description into the "Search for item" field. Or, if stock lines
are in use, select a stock line by clicking "Group by line".

Stock items to be weighed
Items to be weighed can be set up without the need to install an integrated checkout scale. If you
aren't using an integrated scale the POS behaves slightly different from when it is dealing with
non-weighing items. To see how the POS deals with weighing when you enter a stock or barcode
for such items go to processing POS sales.
Stock items can be set up to allow the use of non-integrated scales. In that case the POS
switches to manual mode so you can enter the weight once it is available. You may need to
remember their stock/PLU code if you don't pre-package them and use a weight label. Or you can
use the menu button, weigh the item and then enter the value of the weight into the Quantity field.
For example 1.25 for 1.25kg.
The rest of this section describes setting up items that are to be weighed and prices calculated
using the scale weight.
1. Set up the required stock items for the items to be weighed. Each set of menu buttons can
have up 120 items in it. You can set up 60 menu line buttons. A total of 7200 stock items can
therefore be allocated to menu buttons.
2. Create the required stock items. As you create the items, click the "Sales settings" tab.

Notice the "Weigh item" box is checked.
A weighed item has a three decimal place level of accuracy. As follows:

Place the item(s) on the scales. Wait for the weight to appear on the scale display. Then click the
item's button.
3. If the item is to be placed in a container prior to being weighed click the "Get tare" button and
place the container on the scale.

If your customers use containers they supply themselves, and you operate a help yourself store,
then make sure they have an accurate tare weight on the container. You can then manually enter
the tare amount into the tare field.
With tare selected the POS appears as follows:

Note - make sure you clear tare when the relevant item has been weighed. To do so click the
"Clear tare" button. As you can see that button also displays the current tare value.
If you set tare on the scale DO NOT use the get tare option.

Stock lines and groups
You can use stock lines, and groups, to enable you to manage your stock.
For example if items belong to stock lines you can split your stock take by lines. Rather than
having to carry out an entire-store stock take. This makes it more manageable if you have a
large inventory.
When an item is linked to a stock line you can also arrange group sales. To do this make sure
there is at least one group for each stock line. If there is only one group for any stock line then
you can simply arrange a sale for all items in that line by setting up the sale for the single group.
Include BOTH stock lines and groups to report on sales by stock lines and groups. You can also
report on stock lines only if you aren't using groups.
There is an option to report end of day sales by line as well.
To create stock lines click "Stock lines and groups" in Stock Management.

The following form activates:

Note - from this form you can create both lines and groups

· To create a new line click "New".
· Enter a code - it has to be unique.
· Enter a description. You can ignore the "Add description". This appears on reports and forms
that link to the line - eg Stock Maintenance.
· Click Save.
You can now create groups for the existing line.
To create a group click "New Group". The following form activates:

· Enter a code
· Enter a description. This appears on reports and forms that link to the group - eg Stock
Maintenance.
· "Sales tax enabled" is checked by default. If unchecked any items that belong to this group
will not have sales tax calculated.
· Leave "Sale on" unchecked unless you intend to activate a group sale. If you want to set up a
sale for later check it and then enter the details for the sale. Then uncheck it.
· Optionally enter sales details - the percent that applies and the dates the sale is to be active
between.
· Click "Save group".

Multi-item discounts
Multi-item discounts are an alternative form of volume discount to using price breaks. Where
price breaks allows multiple levels of discount for a single item, multi-item discounts pricing only
allows one discount level for multiple items and applies to multiples of the number to be
discounted. For example - if multi-item discounts are set in multiples of two the third item does
not have the discount applied. However if 4 items are purchased the discount price is applied to
the third item as well as the fourth.
For example: Multi-item discount is set of $3.00 for the purchase of 2 of Item Y. Normal price
$3.25
1. Cashier scans one of Y. Price $3.25
2. Cashier scans one of X - normal price for X
3. Cashier scans second of Y - Price $3.00 - total price for all Y purchases now $6.00
4. Cashier scans one of Z - normal price for Z.
5. Cashier scans third of Y. Price $3.25. Total price for all Y purchases now $9.25.
As you can see the items can be scanned in any order.
To set up multi-item discounts click the Multi-item discounts button on Stock Management. Or
in Retail Business Settings. If the item already has price breaks set you will be warned that they
must be cleared before a discount can be applied.
The following example sets discounts to be applied to various Amital drinks when a customer is
purchasing multiples of 2.

· Click the button "New price discount"
· Enter the multiplier and discounted price. From example "2" and then divide the total 2 of the

·
·

items at discounted price by 2. For example - if an item is normally 3.00, then 2 are normally
6.00 and the discounted price for 2 is 5.00. Then the discounted price, per unit, is 2.50. That
is what goes into the "Discounted price" field.
Click "Save discount"
Click the button "Select stock item" to add an item to the list. Select it from the list.

Second hand items
See also item details.
In the case of secondhand items it is common to have the same stock item with different prices.
This is because of the difference in quality of the item - be it books or furniture or white ware, or,
for that matter, anything else. The POS has the facility to activate a pick list of such prices when
an item has multiple prices. They are called Item Details on the Stock Management form. The
option can also be used for clothing styles. Or anything else where the price is either the same,
or different, but the description changes and you need to track how many there are in stock.
Because such items can use the same codes (including bar codes) it is necessary to deal with
them as part of a single stock item, but with differing prices (optional) and descriptions to help
identify them.
To do this you need to activate the Item Details button on the Stock Management form. To
activate the button go to POS Settings, click Edit and check the box "Enable multi-item sales
selection (styles, colours, prices)" .

Once you have done so the stock management form will look something like the following:

Note that there is now another button active at the center right - Item details.
When setting up secondhand items that are to have details do not include a value for No. in
stock. This is updated as you enter the number of items for each detail item. You need to enter
a buy and retail price for each detail item as well. In the case of secondhand items you will need
to change the price and description to make it clear which detail is to be selected from the pick
list.
Once you have entered the details for the primary stock item click the Item Details button. The
following form is activated:

· To add an item click Add.
· To edit an existing item click Edit.
· To record the return of an item click Return. If an item has been sold click Sold. These two
buttons are only required if you need to make manual adjustments to the inventory level.
Generally they should be ignored.
When you click Add the following form activates. Note that the description of the main stock item
is used. You should modify that to more closely match the detail. This description is the one on
the sale docket when it is printed. It is also the one used on stock orders and invoices.

· Retail price defaults to the same as the retail price of the main item. You can change this if you
wish. In that case this price is the one used when making sales.
· You can enter another buy price if there is one. For stock take purposes the main stock item's
buy price is used. So, if there are variations in buy prices for detailed items the main stock
item's buy price should be an average of the buy prices for all detail items.
· The item code defaults to the same code as the main item. For simplicity sake it is a good idea
to leave it unchanged. This is the code that prints on the price labels when you generate them
from this form. Doing it this way enables you to use a common bar code and still identify the
correct style item.
· Date of purchase defaults to the same day as you create the details.
· Enter the stock level of this detailed item. The value entered here is added to the total stock
level of the main item.
A pick list activates as soon as the relevant stock item has been selected in the POS - either
manually, using a scanner or selecting from the stock list.
When a stock item with details is selected the POS will look something like the following:

In this case the only difference between the details is the description. Both price and stock code
are identical.
If more than one is being purchased change the quantity. Or you can select the item, then click
Change and change the quantity on the main POS form.

Creating barcodes
If items don't have barcodes you can create them in Stock Management. Retail Business does
not require that you use barcodes. But using them can save you a lot of time and lessens the
chances of error.
If an item has no barcode setting up one is straight forward. In Stock Management click the Add
button and enter no more than 12 numbers (they must be numbers) into the Bar code field.
When you have done so the Stock Maintenance form has a button visible "Barcode check
digit". As follows:

Getting the check digit correct is the key to a proper barcode. Without that digit the scanner will
not recognise the barcode as valid.
When the Barcode check digit button is clicked the check digit is created and added to the code
so far entered. As follows:

The check digit created in this case is 5.

Combo deals
Combo deals can be set up from Stock Management.
Combo deals are specials where the purchase of a certain item (at the normal price - possibly?)
allows the purchase of a set range of other items at special prices.
Eg "Buy one Happy Meal and get a full serve of chips at half price".
To set up a combo deal the item the deal is to be for must not already have options or be a
package. Nor must it be part of an existing combo deal. However it can be the main item the deal
is associated with.
The following example has three items that are part of a combo deal - the "tan" colour bar on the
item list. The master item is the "Hills quattro 4 retracting c/line..."

To edit, or add, items to an existing combo deal highlight the master item (the item that must be
purchased first) first. Then click the "Combo deal" button.
The following form activates.

· The description of the item that will trigger a combo deal is at the top.
· Enter the number of items to be included on the combo deal. This is the number of items that
will be entered as the quantity on the POS docket.
· Enter the Combo price - per unit. This is the price that is used. Not the retail price which is for
reference purposes only.
When the combo deal ceases remove all the items from the deal.
In Retail Business, so long as the "master" item is already on the docket list, any other items
included on the combo deal can be selected.
The number of the items the combo deal applies to, and the deal price, are used.
following example shows.

As the

"Combo deal" is added to the item's entry on the docket.
Combo deal items may not be changed. You must void them instead.
If a combo deal item has already been included on the docket, and you add an additional one, it
is treated as a normal item. The special price does not apply.

Stock take
You can activate stock take from the POS - "Manage stock" or Stock Management.
To help make stock take easier consider doing the following:
1. Create stock lines and organise your shelves on the basis of those lines. This is because
stock take can be carried out line by line rather than the entire inventory;
2. If the store/warehouse is within 10 metres radius of your work station consider buying a blue
ray bar code scanner and creating bar code display labels for items that don't already have bar
codes.

· Load from inventory. Stock take is done "off line" and the stock levels updated when you
click "Update stock". WARNING - if the stock take level for any item is 0 that will be the new
level when the inventory is updated.
· If you have set up stock lines, and wish to use them when doing stock take, select the use "By
line" option.

· Once the stock take is loaded enter/scan the bar code and then enter the Number in stock.
Keep doing that until you've finished.
· The number of items updates immediately you scan another item.

Linking items
In certain cases you may wish to link similar items together to obtain comparative reports of sales
success. You can use the Alternate search code field in Stock Management for this.
This is useful if, for example, you stock multiple copies of a single book title but that are different
in certain respects. For example the title may come from more than one supplier. It may have
different covers (softcover/hardcover) and may be differing prices. The items may also have
different barcodes and stock codes. In fact they must have.
To link items use a common code for the items you wish to link together. It must be identical for
all the linked items. When it is set up you can generate a sales report that includes the details of
all items that are linked using the relevant code.
To set up multi-item linking select the first item to be linked. Enter the code into the "Alternate
search code" field. As follows:

Note the code is "TRAN" - the first letters of the item's description. To the right of the field is a
search button. Click the button to display stock and search by alternate code when entering a
new one. The software doesn't check for existing codes, or duplicates. What goes in this field is
entirely up to the user. The list is the same one as in the lists group - "List/Select". If you enter an
alternate code only those items with a close, or exact, match will display. As follows:

Use this to make sure you're using the correct code and that the correct items are being linked..
Once stock items are linked you can use the report "Linked items - using alternate code" to
compare sell through rates for those items.

Stock item options
Item options allows you to select options to add to the sales docket. Any stock item can have
multiple options. For example:
1. A bike can have options such as - carry pack, speedometer, a range of different pedal types,
etc.
2. Takeaways can have (eg battered fish) - no salt, additional scoop of chips, salad, sachet of
sauce, etc.
3. Hot drinks (eg coffee - mocha) can have - have here, extra cream, cinnamon, extra chocolate,
etc.
It is possible to go to a second "layer". If we take the second example the salad can have its own
set of options:

· Vinaigrette, no mayonnaise, balsamic vinegar, etc
And a third "layer".
Options don't have to have a price. They can be instructions only. As in "no mayonnaise". If the
options have their own price that price is added to the total value of the transaction.
To activate options go to POS settings and check the box "Activate takeaways/menus/options
for this lane." The default setting is to use packages. So you must activate options before you
can use them.
Note - if options are enabled packages no longer work. All packages previously set up will now
act as if the items in them are options. That means you need to either delete all packages or
change packages into options. To do that set the retail price of the package to zero and select
each item to add to the option when the options selection form activates.
Options behave in a different way from packages. In that the price of each item, when selected
from the button, is ADDED to the POS docket. Options can also be removed from, and added to,
the docket.

Creating new options
To create new options, or modify existing ones, go to Stock Management. Select the item the
option(s) are to be for. Click the "Options settings" buttons.
If the "Options settings" button is not visible you need to activate it by going to POS settings and
checking the box "Activate takeaways/menus/options for this lane".

An option item can also have an option. As can an option of an option. But that is the limit - 3
"layers" of options.
For example
1. Stock item with options - Pizza. This has no price.
2. First layer of options - large pizza, medium pizza, small pizza, special pizza. The first three
have a price.
3. Second layer of options - for special pizza. Large, medium, small. All of these have prices.
4. Third layer - mushrooms, extra ham, pineapple, cheesy crust. Some of these may have prices.
If you are running a takeaway, cafe, etc it is a good idea to make sure all items with options, and
their options, are set as being printed on the First kitchen printer. In Stock Maintenance. This
ensures they will all print together on orders. Even if you don't have a separate kitchen printer.
They will print in the order entered on the POS if you print the receipt.
The POS also deals with items that are assigned to a kitchen printer by making each entry
appear on a single line. The quantities aren't incremented as it is possible that options are
different even though the item is identical. Kitchen staff need to know which options go with
which ordered item.

Each option layer can have up to 30 additional options.
Note - make sure all the required options have already been created (as stock items) in Stock
Management.
· Select the item in Stock Management for which you want to create options.

· In the above case Tropical pizza has been selected. Notice that the list below it also relates to
pizzas. These are used to create various option lists.
· The case of Tropical pizza we want to create options for differing sized pizzas.
· Tropical pizzas have already been set up as stock item buttons for a Takeaways stock line.
Along with Traditional pizza and special pizza.
· Notice the list includes three different tropical pizzas - small, medium and large.

· Click the "New button" button and select the option item from the list. You cannot select the
item these options are for.

· If that is all click "Save".
· If you are using kitchen display orders and want these options to print on those orders check
the box "Print in group in display orders".

· If you wish to include non-English characters (Chinese, etc) on the button enter the characters
into the "Add caption" field.
Tropical, special and traditional pizza have been set up as non-stock items with a retail price of
$0.00. It is the differing sizes that have the price. The above example has no further options.
As you can see this one already has options set up and displaying. The buttons always display
the option items in the order they have been entered into the options list. This means, if you wish
to insert one into the existing list at any position but the last, you need to delete the options until
you get to the option it is to appear after. Then re-enter the options you removed.
Now let's look at options that, in turn, have options. We will use special pizza.
The following are the special pizza size options. Again there is a price for each size.

Each option size is to have topping options. Those options are going to be the same for each
size. Some will have a price, some won't.
As follows.

Notice that Special sauce has a price. The others may have prices as well. Or none.
You MUST set up the options to each item the options are to apply to. It is not safe to assume
that one, similar, item will automatically have the same options as its relatives. Setting up one
size DOES NOT mean the other sizes have those same options. This is because options may
vary between other wise similar items.

It is a good idea to set the buttons up so the most popular options are on the top row. And also
set them up so that related options are grouped together. That minimises the amount of "hunting"
the cashier will need to do to select the correct option.
Also make sure the option descriptions are short and clear.
You can have up to 24 options at each level.
Once options have been set up you can select them from the items buttons. The following
example uses Takeaways (the stock line)
If an option also has options selecting it results in those options being made visible.
With options set Retail Business operates as follows.
1. Click the relevant menu button. That menu's stock item buttons become visible.
2. Click the relevant item button. Notice that "Special pizza" does not have a price.

3. Now click "Large special pizza". The options become visible. Select the options you want and
click Finished when you have selected all you want.

Notice that there is a price in the "Large special pizza" line on the docket. Olives topping also
has a price. Ham topping does not.
You can also set up items and options so they print on orders together.
When the Options are finished with, and the options buttons closed, Retail Business will look
something like the following:

Note that not all lines have prices. The others are either to confirm the customer's order (they are
included on the receipt) or to go on an order for the kitchen staff.
The takeaway items are also in bold. That is to highlight that they are kitchen items. The spacer
is being used to make a visual distinction between the kitchen items and the ice cream as a way
of making things easier for order staff if the docket is to be printed on a single order.
If the POS response (in Stock Maintenance) selected for the items on the docket are to print on

an orders, or kitchen, printer an order will be printed off immediately tendering is complete. Items
that have "Normal" as the POS response don't print on orders.

Uncompleted sales
When the POS first starts up it checks to see if any transactions were interrupted. That is if there
was a power failure or the system crashed for some reason. If any are found the following
message "X sales were interrupted. Please review and complete" displays. To clear this
message click the Review button and select the first receipt you see that doesn't have a Type.
That is the field Type is blank. If it was supposed to be an EFTPOS sale you should match it with
the receipt your EFTPOS system printed when the computer recovered and process it as an
"Offline EFTPOS" sale. Provided the transaction was completed by Paymark. If none have been
printed you can select whichever payment type you recollect it should have been.
To make it easier you can also check the "Display interrupted sales only" box. As below:

Uncompleted sales can be removed if the customer left and the transaction was not completed.
In that case select the sale from the review form - click Complete/clear sale, and click Clear
item to clear the items from the docket.
This option assumes the transaction was interrupted before it was accepted by your EFTPOS
provider. You need to run the "Check last transaction" option on the POS functions selection form
to see if that has happened.
Most EFTPOS options (all?) allow for a limited number of transactions to be processed as
electronic offline vouchers (usually up to 90 or so). That situation is triggered when two have
been failed as a result of a loss of communications. In that case the EFTPOS terminal will report
that EOV mode is active. If it is your cashiers need to obtain the customer's signature on receipts
when initially processed. The transactions carried out in EOV mode are sent through to the
EFTPOS provider as soon as the terminal reconnects.
In EOV mode the EFTPOS terminal will still respond to the POS. So the transactions can be
completed as normal EFTPOS sales. The EFTPOS terminal will send them through once
communications come back.
If, for some reason, the connection between the EFTPOS terminal and the POS no longer works
select "Other tenders"-> "Offline EFTPOS". Such transactions are included in the end of day
summary.

Cash pay outs
To take cash out of the till for incidental expenses (postage, milk, courier, etc) click the Pay out

button. The POS goes to manual mode and one field is active - Cash pay out. The Code/PLU
field displays "EXPENSE" and cannot be edited. Enter the amount and then click Other
payments. You will be prompted to print a receipt. It is a good idea to do so as it includes the
purpose of the payout. Then keep it for your financial records and G.S.T. imputation.
Pay outs are included as part of the end of day.
When making a pay out you may not include it with any other docket items. A pay out must be
the only item on the docket. If you attempt to do so you will be warned and the POS will not
change its state to allow entry.
In pay out mode the POS appears as follows.

If you don't have a keyboard use the number pad to enter the pay out expense amount.
When making a pay out, once you click Accept the following form is activated. You must enter a
reason for the pay out or the form cannot be closed.

That reason is then included as the description of the item on the docket. Click Other tenders to
complete the transaction. You will be prompted to print a docket.

You can review pay out receipts - they display as having a Payout sale type. To produce a report
of pay outs go to the POS reports form->Cash sales and check the box Pay outs only.

Processing EFTPOS sales
If you have installed EFTPOS integration the Retail Business selection form attempts to logon to
Paymark when it activates. If it succeeds the tendering form includes a "To pinpad" button. If
the connection fails you need to check with your ETPOS provider to ensure the pinpad was
installed correctly or that there is no other problem with the connection.
Integrated EFTPOS sales processing is controlled by messages between the POS (Retail
Business) and the pinpad. Generally this means the POS checks to see if the payment was
processed by the pinpad successfully. If processing is completed successfully the sale is
completed as normal. The payments processing form behaves slightly differently depending on
the EFTPOS provider.

Integrating EFTPOS
Professionals Retail Business, supports the following EFTPOS integration options:
1. DPS Payment Express.
2. EFTPOS NZ - EFI interface
3. Skyzer (Ingenico) - Nitro interface
4. Skyzer (Ingenico) - two-way interface
5. WolfStrike - two-way interface.
6. SmartPay - SmartConnect
7. Verifone VXLink - serial connection

To integrate EFTPOS first install the required installation files from your EFTPOS provider. If
required. In the case of the Ingenico terminals your installer needs to install the Skyzer - Nitro
library. Or, alternatively, the two-way communication method can be used.
When installing NZ EFTPOS (ANZ) make sure you select the NZEFTPOS - EFI interface option
when installing the EFTPOS software.
Once the EFTPOS terminal and/or pinpad software has been installed you need to let the
software know it is installed.
If you have only the one lane select System settings -> POS settings. Other wise click Select
POS functions -> Lane Settings The following form activates:

· Click the Edit button.
· Check the "Turn on integrated EFTPOS" box.
· Four additional fields and/or buttons will appear. As below. This example shows the settings
for NZ EFTPOS - EFI interface

· Select the EFTPOS option you have installed.
· Enter your merchant id - this is only required for DPS Payment Express. You may wish to enter
your merchant id anyway as a means of checking in case you need it.
· Enter/select the installation data about the location of the configuration file, communications
port or required folder. In the case of DPS Payment Express you need to locate the file
"psxcrcontroller_cfg.txt". That file will be in the folder C:\Program files\DPS\eftpos_scr\ on a
32 bit WIndows PC and in C:\Program files (x86)\DPS\eftpos_scr\ on a 64 bit Windows PC.
If you have selected NZ EFTPOS - EFI interface the folder C:\EFTPOS\ is placed in the field.
This is the default folder the NZ EFTPOS client looks for the required transaction files. If you
used another folder when setting up NZ EFTPOS you need to change this. If you do, make
sure the '\' is on the end of the folder name.
The following example shows the settings for DPS Payment Express:

Once you have set up the software to link to your EFTPOS provider the tendering form includes
additional buttons. The "To Pinpad" button will always display. The others depend on the
behaviour of your EFTPOS installation.
In addition the software attempts to connect to your provider (and the terminal/pinpad) when you
open the Retail Business functions form. If the connection succeeds you are advised. Also if it
fails. If it fails contact your provider to find out if there is something wrong. If it fails at this point,
and you continue to activate Retail Business, the "To pinpad" button is disabled and you must
carry out sales using the Offline EFTPOS option.
Note :- Retail Business allows the pinpad to print out the EFTPOS receipts. If it has a printer. You
need to configure the EFTPOS to link to the correct receipt printer. It will need to be the default
receipt printer. This means, even though Retail Business can recognise the receipt printer based
on the settings you enter into POS settings, the EFTPOS link must use the default receipt

printer. Printing EFTPOS receipts is, usually, a requirement. And is mandatory when the
transaction requires a signature. You can still print off the normal POS receipts should you wish.

DPS Payment Express sales processing
The tendering form behaves in the same manner for the Ingenico two-way terminals.
The pinpad is controlled from the POS. All messages appear on the sales processing form and
all actions are initiated from the sales form. There is one, possible, exception. To take the pinpad
to manual mode it may be necessary to press the "Back" button on the pinpad rather than the "To
manual" button on the POS. For some reason certain pinpads do not respond in a timely fashion
to the POS command to go to manual mode. Manual mode is where the customer has to enter
their complete card details into the pinpad. You can also use it to complete sales over the phone.
1. Normal mode sales - no signature.

· The amount to pay is in the Tendering field. If the customer wants to split their payment
between cash and EFTPOS, or EFTPOS and a specific credit/debit card, select the relevant
button on the POS.
· Click the "To pinpad" button. The processing forms appear as follows - the pinpad is awaiting
the customer's selection of the account after they have swiped their card.

· The response from the pinpad appears in the fields at the top right. These are the same as the
customer sees on the pinpad
· Until the customer has swiped the card, and the card has been authorised, it is possible to
cancel the transaction. If the pinpad is waiting for the card to be swiped it is possible that it
won't respond to a cancel command from the POS. Press the Cancel button (the red one) on
the pinpad if that is the case.
· When the customer has swiped their card, and the card has been accepted the tendering form
is shut down:
· Once the sale has been authorised the EFTPOS receipt prints and you are given the option to
print the normal receipt as well.
· You are returned to the main POS form.
· DPS Payment Express always provides the option for the customer to enter the card details
manually. As a result the "Manual entry" button is displayed and active. It is possible this
button will not activate manual entry until the customer has swiped their card. If that is the case
press the Back button (the yellow one) on the pinpad. That also activates manual entry.
2. Signature required.
To activate "Signature required" the customer must press the Enter key on the pinpad when
prompted for "Pin or enter". Or the card is one that defaults to requiring a signature. Or the
purchase is of a value that requires a signature. In the later two cases "Signature required"
activates automatically as soon as the card is swiped.
When "Signature required" is activated the tendering form includes two buttons under the
message fields. First the POS prints a merchant copy of the receipt. This needs to be signed by
the customer. Compare the signature with the signature on their card. If they match click the
"Yes" button. Other wise click the "No" button. If the "No" button is clicked the transaction is
cancelled.
In all cases, if a transaction is canceled, you can prompt the customer to use another card or
payment option.

Immediately the card has been accepted the POS pops up a prompt to advise the payment has
been accepted and requests whther you wish to print a receipt..

PC EFTPOS (ANZ) EFI sales processing
The pinpad is controlled from the PC EFTPOS client software. The only messages that appear
on the sales processing form are whether the transaction was accepted or not. All actions are
initiated from PC EFTPOS form.
1. Normal mode sales - no signature.
· The amount to pay displays in the Tendering field. If the customer wants to split their payment
between cash and EFTPOS, or EFTPOS select the relevant tendering option on the POS.
· Click the "To pinpad" button. The processing forms appear as follows - the pinpad is waiting for
the customer to swipe their card.

· The response from the pinpad appears on the client application. These are what the customer
sees on the pinpad
· Until the customer has swiped the card, and the card has been authorised, it is possible to
cancel the transaction.
· When the customer has swiped their card the processing form appears as follows when the
card has been accepted:

· Once the sale has been authorised the EFTPOS receipt prints and you are given the option to

print the normal receipt as well.
· You are returned to Retail Business.
· PC EFTPOS always provides the option for the customer to enter the card details manually. As
a result the "Manual" button is displayed and active.
· Note that the tendering form has already been closed down. Click the Accepted button to
return to Retail Business. If you don't the NZEFTPOS form shuts down after about 5 seconds.
PCEFTPOS allows you to access the control panel. To do so click the EFTPOS control panel
button on the Retail Business selection form. The control panel allows you to carry out a range of
operations. To carry out a settlement cutover, or settlement inquiry, click Administration. Some of
these operations require that you know the passwords. Please refer to the PCEFTPOS
documentation for details.
2. EFTPOS refunds.
If the customer requests a refund you can arrange to complete it using PC EFTPOS. The cashier
(or you) must have the merchant number, and merchant card if using the Ingenico two-way
terminal, to be able to do this.
To initiate a refund process the return as usual. That is, click "Refund/Credit" once the stock
item is on the docket list. If the customer isn't purchasing anything in addition to the refund the
total value of the sale will be negative. Click the Tender EFTPOS button.
The payments processing form activates. Click "To pinpad".
Enter the merchant's number. If this is the correct number the NZ EFTPOS form will activate and
request confirmation of signature. At this point a receipt is printed. The customer needs to sign
the receipt. If the signature matches their identification (you did ask for one didn't you?), click 'Sig
approved". The refund will then be completed.

Verifone VXLink
Verifone VXLink is a "simplified" two-way integration option. By "simplified" is meant that the
POS only reports one message from the terminal if the transaction is successful "PROCESSING". Or a failure if it fails.
You need to purchase, or lease, a VX 520 EFTPOS terminal. Have it configured for serial, twoway communications.

Ingenico EFTPOS terminals
Professionals Retail Business supports the Ingenico series of EFTPOS terminals using either
Nitro or the Two-way interface.
The terminals supported are: iCT220, iCT250, iCT330 and iWL252 and Desk/3200.

· First check the box "Turn on integrated EFTPOS".
· Select the terminal.
· Select the communications port. The terminal must already be connected for the port to be
recognised.

If you don't have one of these terminals, and you are leasing, you should be able to obtain one by
swapping terminals. If you own your terminal, and it doesn't match, then you need to replace it.
The terminals listed are the only ones that support POS integration.
If the connection fails - that is the "To pinpad" button is disabled, or is not visible - exit from the
POS and attempt a logon by clicking the "EFTPOS logon" button. If that fails you will still be
able to carry out sales. But all EFTPOS transactions will need to be completed as offline. Or you
can disable EFTPOS integration and use the EFTPOS terminal as a stand alone until the issue is
sorted out.
You can attempt to logon again by clicking the EFTPOS logon button on the POS functions form.
You may complete end of day settlement enquiries and cutovers by clicking the relevant button.

Ingenico Two-way sales processing
The pinpad is controlled from the POS. All messages appear on the sales processing form and
all actions are initiated from the sales form.
· Allocate the amount to pay to the relevant fields. If the customer wants to split their payment
between cash and EFTPOS, or EFTPOS and a specific credit/debit card, make sure the
amounts are correct in the relevant fields.
· Click the "To pinpad" button. The processing forms appear as follows:

· The response from the pinpad appears in the fields at the top right. These are the same as the
customer sees on the pinpad
· To cancel the transaction press the Cancel button (the red one) on the pinpad. Not the cancel
button on the payments tender form.
· Once the sale has been authorised the EFTPOS receipt prints and you are given the option to
print the detailed POS receipt as well.
· To go to manual mode press the Back button (the yellow one) on the pinpad.
In all cases, if a transaction is cancelled, you can prompt the customer to use another card or
payment option.

Smart Connect integration
Before you configure Retail Business for Smart Connect make sure you have the correct terminal.
SmartPay will provide that as well as the id and connection details
Once you have the terminal go to "POS settings"-> "EFTPOS integration" and select Smart
Connect.

· Enter the pairing code from the EFTPOS terminal. Contact SmartPay for how to do get the
pairing code.
· Click the button "Pair with terminal".
Once you select SmartConnect the software looks for the domain address that enables you to
process payments.

Once SmartConnect has been set up the software will connect when the POS functions form is
selected. In addition certain administrative tasks are carried out. You can optionally reprint the
last transaction so the cashier can verify it was completed correctly and any transactions that
were processed offline are uploaded to Smart Connect.

Smart Connect tender processing
When tendering payments SmartConnect handles most of the processing itself. The POS
initiates the tender process and checks for a response from SmartConnect to know whether the
payment was accepted or not.
This means the responses are handled, and displayed, by the EFTPOS terminal once "To
pinpad" is clicked. As follows:

If the SmartConnect connection fails for any reason the cashier needs to go to the main menu
form and restart the EFTPOS terminal. If the connection was down for any time and the cashier
carried out offline EFTPOS transactions they will be uploaded once the SmartConnect connection
is reestablished.
It is possible that the pinpad may lose its connection to Paymark after the signature required
transaction has been accepted. In that case the cashier can either:
· Cancel the tendering process, reconnect the pinpad then restart it. Pressing To pinpad
triggers a request to reprint the last transaction. If the EFTPOS receipt shows accept Cancel
the processing and return to the POS. Then select Other tender and process the payment as
an Offline payment.
· If the pinpad will not reconnect to SmartConnect you may need to shut down the PC and
restart. Then restart the POS. When you do so the last transaction is reprinted. Check if it
was accepted. If it was then as for above. Only this time you need to Review the interrupted
sale (it will have no Type) and then select Other tender and Offline payment.
· If the pinpad reconnects quickly the last receipt will be printed immediately. If it was accepted as above.
· If you suspect this transaction may have been completed prior to a connection failure click the
button "Last receipt". The terminal prints the last receipt completed.
If the transaction was not accepted you can decide whether to complete processing (assuming
the customer stayed around) or cancel and void the docket.
When the POS starts up it will report "X sales were interrupted". To check the transactions select
Review and select the last sales with no type. Or check the Display interrupted sales only box.
That will be the transaction being processed when the connection was dropped. If the transaction
was split, or the connection failed after a signature was accepted, you need to carry out a
balancing entry of the amount of the transaction that was accepted by the Paymark network.. If
the full transaction was successful process the transaction as an offline transaction (select "Other
tender"). Otherwise void the transaction, create a new transaction and manually adjust the value
to match the amount completed successfully.

EFTPOS terminal errors
If the terminal loses connection to Paymark
In this case you will be prompted to switch to "EOV mode" (electronic offline voucher). To carry
this out allow the first transaction to fail. Then try again - with the same card. Once that has been
accepted the terminal will be in EOV mode until the network connection is re-established.
Once it is re-established the terminal will report that it has uploaded the EOV transactions. In
EOV mode the terminal responds as if the transactions are all signature required. This is
because Paymark cannot be contacted to confirm the card is good for the funds. In that case
make sure your cashiers obtain the customer's signature.
You can, generally, complete up to 99 transactions in EOV mode. After that, if the connection still
fails, you will need to accept cash only.
If the terminal fails during transaction processing.
When the terminal fails is important. If the terminal fails to complete a transaction reprint the
receipt to check the last response from Paymark In all cases wait for the tendering form to
display "TRAN FAILED" "Try again?"

· If the terminal fails after Paymark accepts the payment then complete the transaction as an
Offline sale. Go to "Other tenders" from Retail Business.
· If the transaction is split between cards, and fails after the first one is swiped. If the first one
was accepted by Paymark you have a choice:
1. Refund that payment. Then process the full transaction. That ensures the stock level is
correct.
2. Process the completed payment as an offline sale (Other tenders). To do that manually
change the sale value to match the amount that was processed. Make sure you don't change the
number of items on the docket. Then carry out a "dummy sale" using a "MISC" item that is also
non-stock. This makes sure the stock levels are correct.
· If the terminal fails before Paymark accepts the transaction wait for the tendering form to
respond with "TRAN FAILED" "Try again?". When that happens check the terminal is still
connected. If it is try again. Or cancel the transaction if the terminal is displaying a fatal error.
In that case you need to contact your EFTPOS provider.
· If the terminal fails immediately after the screen shows "ACCEPTED" but before the EFTPOS
link reports "PAYMARK EFTPOS" reprint the last receipt when the terminal reconnects. If the
receipt shows the transaction was accepted exit the tendering form and complete the
transaction as an offline sale. If it was not accepted complete it as normal.
· If the terminal fails during a signature required transaction - always reprint the last receipt:
1. If the terminal reports ACCEPTED prior to failing. If the transaction was accepted complete the
transaction as an offline sale.
2. If the receipt shows the transaction was not ACCEPTED complete it as a normal transaction.
· If the terminal fails during a multi-card transaction but after the first part has been approved.
1. If the workstation has to be shutdown you will be warned that a transaction was only partially
completed when Retail Business restarts. Recover that transaction from the review list. Process
the transaction for the balance remaining. That will be the amount displayed.
2. If the workstation does not need to be shut down. Stay on the tendering form and wait for the
terminal to reconnect. Reprint the receipt if you are in any doubt about whether the first card's
component was accepted. Then process the balance as normal.
3. If the customer is not prepared to wait then process the balance as a cash sale. Assuming
they have cash. Of course.

Multi-tender EFTPOS sales
To process multi-tender sales using more than one customer card first ask the customer how
much they wish to put on the first card. Enter that amount into the Tendering field. The balance
owing displays at the top of the tendering form and that amount is also placed into the EFTPOS
field when the first card's processing is complete.
When using integrated EFTPOS click the To Pinpad button to activate the pinpad. If using the
non-integrated POS click the Accept button once the customer's card has been accepted..
The tendering form will be shutdown, and you are returned to the POS, once the balance to pay
is zero. If using integrated EFTPOS, and the customer wishes to not complete the sale after
having swiped at least one card clicking Cancel results in the amount, so far entered, being
refunded. This also means that someone needs to know the merchant password required to
complete a refund.

Exchanging stock items
To exchange items, and assuming the customer isn't purchasing anything additional, you have to
set the POS to allow transactions with a net value of zero. This means you need to check the
box "Allow free items/gifts/exchanges" on the POS settings form - as follows:

Warning - only turn this option on if you are confident your cashiers can be trusted. Because
"free sales" have no receipt record. You have to run the Free Sales report option to see who by,
and when, any were created.
Enabling this setting means transactions can be completed when the net value of the transaction
is zero.
When exchanging an item in the POS first deal with the returned item. Scan/enter the item's
code. Click the Refund/Credit button to refund the item.
Then scan/enter the code for the item the exchange is for.

Click "Other tenders". You will be prompted to print a receipt
Warning - if the exchange is of the same item there will be a single line entry on the docket, with a
quantity of 2, but a value of zero.

Opening cash drawer with Windows generic text printer
drivers
If your receipt printer doesn't have any printer drivers you may need to use the Windows Generic
Text only printer driver that you can install using the option to Install Printer - select Generic text
only. This means you may not include your company logo on the receipt format.
Once you have installed the generic text only printer you need to modify the settings so it will
open the cash drawer when you need it to. The following settings are for the Javelin JP88 printer.
1. Select the Generic printer in Devices and printers. You may need to create a new printer. In
that case select "Generic text printer" when prompted for the model.
2. Right click the Generic printer and select Properties. That following form is activated.

3. Select the Advanced tab and modify the form as follows:

Check the button "Print directly to printer". This makes sure the printer prints the receipt quickly
with no delay.
4. Then select the Printer commands tab and modify it as follows:

In the field End print job put the following characters: <1B>p055<0A0A1B>V1 The letters must

be in the case shown. This will open drawer one, do two line feeds and then issue a cut
command.
If you just want to open the cash drawer enter <1B>p055. These instructions should work for
most printers that use the Epson command set.
Make sure there are no spaces between the characters.
5. Click Apply and Ok to update the settings.
If you have another model of receipt printer that doesn't have a printer driver you need to find out
what the codes are to open the cash drawer. The best way to do this is to go onto the website of
the manufacturer and look for "Technical Help" or something along those lines.

How to set printers to open cash drawers
Most receipt printer drivers have a default setting that means they don't open the cash drawer
when initially set up. You may need to modify the printer settings to do so.
1. Select Printers and devices.
2. Select the receipt printer and right click it. Select Printer preferences. Don't select Printer
Properties.
3. A form something like the following is activated - this is for an Epson TM-T88IV. Your form will
differ if you have another printer type.

4. In the case of the Epson you can select Open before or Open after printing.
5. Change to whichever setting you prefer and click Apply then Ok.

Setting up checkout scales
Setting up checkout scales is a two-step process.
1. In Company Control select Edit and check the box "Use checkout scale". Click Save. This
tells Professionals Retail Business that you intend to use scales. Without this setting you cannot
make any changes that relate to checkout scales.

2. In POS Settings the box "Activate checkout scales" will be checked and the button "Change
scales settings" visible and active.

Click "Change scales settings". The following form activates:

The CAS PD-II scale setting is shown here. The only requirement is that it is connected to an
active COM port. To find out which ports you have available select Control Panel -> Hardware
and sound -> Device manager (top right).
In either case you should get a form that looks something like the following:

To display all the coms ports double-click the Ports (COM & LPT). If you are using a new PC
you need to install a USB to serial convertor cable. In the above case COM4 has been assigned
to the relevant device driver. That is the one shown selected in the scales settings form.
Currently Professionals Retail supports the:
1. CAS PD-II, SW1C(RS) and AP1 (price computing)
2. Ohaus Aviator 7000,
3. DataLogic (Magellan) 8300, 8400.
4. Wedderburn DS-866, 770, 771,781 and 788 checkout scales.
If you are using a scale you wish to have supported please contact us. We will check to see if it
can be included. You will need to ship it to us if we decide to go ahead.
The CAS PD-II and SW1C(RS) scales
To enable Professionals Retail Business to use the CAS PD-II checkout scale you need to set the
ECR type to Type 5. Follow the scale's manual to set up the required ECR type. Go into setup
mode as the manual requires and keep pressing the "*" until you get to Type 5. Then press the >0<-.
To use the SW1C(RS) make sure you are supplied with the ER+ cable. NOT the same cable as
the PD-II
The CAS AP-1 (price computing) scale
No changes need to be made to the AP-1. Make sure you have the correct serial cable and
connect it to the PC using a USB to serial adapter if you don't have any hardware serial ports..
The Ohaus Aviator 7000
Only one setting on this scale needs to vary from the default. The scale protocol must be NCI.
See the scale's manual to set that.
The Wedderburn DS-866, 770, 771, 781, 788 scales
The protocol setting must be NCI-ECR Protocol (Type V). See the scale's manual for how to set

that. Or arrange to have it set by a Wedderburn technician before the scale is sent as configuring
the scale is not exactly that simple.
If you do want to try and set up the scale the configuration is as follows:
SPEC 6 RTS/CTS handshaking On, Baud rate 9600
SPEC 7 Stop bits 1, Data length 8 bit, Parity even
SPEC 10 Type V NCI-ECR Metrologic 1011 then SPEC 11 0001
The DataLogic (Magellan) 8300 and 8400
No configuration changes are required to the scale/scanner. Connect the scale and scanner
cables to the relevant serial/USB ports and select the comport numbers in POS settings.
In a networked environment it is possible that the com setting you applied in POS settings on the
base system doesn't apply to each cashier lane. You need to go to "Local Settings" and set the
scale from there.

HP LD220 line display
The HP LD220 customer line display software must be installed AFTER the Epson OPOS drivers
have been installed.
Insert the DVD into the drive and select the folder "Pole Display" then the folder "Pole Display
OPOS". Click Setup.exe.
When you get to the form to select the display to install select as follows:

Once the installation is complete start up the Epson OPOS set up utility, select LineDisplay. The
following display should be there:

Right click "HP POS Pole Display" and enter a new Logical device name (LDN) 'LineDisplay".
There is no point running an interactive health check with this display. It doesn't work.

Setting up POS lanes
If you have Retail Business workstation installed it is necessary to set up each lane so it operates
in the way required. Certain parameters are "company wide" and apply to all lanes. Others can
be configured for each lane.
If you are using EFTPOS integration, or checkout scales, you must configure each lane as
printers and the communications ports will differ between workstations.
To configure your lane first make sure you have installed, and configured the POS settings for the
company. These are set using the POS settings form from the base systems POS functions
selection form.
When you open Retail Business Settings-> POS settings you can see that the form has five
tabs - the first tab is the company wide settings (all cashiers). The rest apply to the relevant lane.

If you are using the Ingenico Two-way integrated EFTPOS option you MUST set up the
communications port for each lane. It is highly unlikely that Windows will allocate the same port
assignment to each serial port on each workstation. This means that one workstation may use
COM1 and another COM2.
The same applies to printers as the printer names may vary between the workstations. However,
if you wish, you can use a shared receipt printer. In that case the networked printer must be set
as shared and be the default printer. As the "Brother HL-2040 series" printer is in the below
example.

The dashboard
The dashboard allows you to obtain a graphical view of transaction activity over a set period of
time. Activate it from the main system form.
The graphs cover total sales (the default), stock item sales, cashier sales and sales by line.

For all graphs change the dates to change the coverage. The default is to display in two month
selection.
To view selected stock items click "Stock" and select the item you want to view.

To view selected cashier sales click "Cashier sales". Then select the relevant cashier.

To see how specific lines are doing click "Stock lines". Then select the relevant line;

Customer sales can be viewed by clicking "Customers"

In all cases, to make the total sales graph visible, click the button you just clicked to change
views.

Customer operations
To activate Customer operations click the "Customers" button on the POS functions panel. This
module is available to those who have purchased Retail Business with Customers.

To view sales and invoice information, and maintain, customers click "Customer operations";

1. Maintaining customers

To add a new customer make sure the Customer details tab is in front. Click "Add";

· If you haven't set the customer code generation as automatic (in Company Control) enter a
unique customer code.
· You MUST enter a last or company name.
· Enter a physical address if you have one. If that is the same as their postal address click the
Copy button. That will enter the address details into the postal address. It is the postal
address that is used on invoices.
· Enter a post code.
· Leave the Open box checked. If you uncheck it the customer is closed and can no longer be
used.
· Phone number, Alt phone and Mobile are optional.
· If you wish to email the customer about anything then enter their email address. For emailing
to work you must have an email client (Outlook, Mozilla Thunderbird, Messenger) installed.
· Ignore "Last job card"
· You can enter notes for additional information you may need to know or that cashiers may need

to know.

· Click "Save" when complete.

2. Customer contacts
· To add customer contacts (for example if the main customer is a business) click "Add' in the
Contacts group. The contacts maintenance form becomes active.

·
·
·
·

Enter a unique contacts code.
You MUST enter a last name
Enter their role if you know it or think it relevant.
Enter a physical address if you have one.
· Enter the postal address.
· Enter a post code.
· Leave the Open box checked. If you uncheck it the contact is closed and can no longer be
used.
· Phone number, Mobile are optional.
· Optionally enter their email address. This is used for information purposes and is not a
replacement of the company email address.
· You can arrange reminders by setting a reminder date and note about that reminder. This
appear on the reminders list when you print it from the Action Center.
· Click "Save" when complete.

3. Viewing, and reprinting, customer sales
Click the "Customer sales" tab.

· From this tab you can view all POS sales made between the selected dates
· You can also reprint the selected docket - click "Reprint docket". It will print on the receipt

printer.
· The total sales for that customer also displays.
· In the above list you may wish to review the status of docket # 6588. It could be on hold.
· To review credit notes for the selected customer click the "Credit notes" button.

This list displays ALL credit notes so far created for the customer. And the balances due for each.
In the above example one credit note's balance has been zeroed. The balance remaining is
$298.50.

4. Customer invoices.
This tab displays all invoices created for the selected customer. That includes invoices created
from the POS as well as from Back Office. Plus any payments made for the selected invoice.

Click "Maintain Invoices" to access Back Office invoice maintenance.

5. Customer Orders
This tab displays all orders created for the selected client within the date range selected.

Either double-click the selected order or click "Customer order" to maintain the selected order
and/or add new orders. You can print a delivery docket from an order.
Also see:
· Managing lay bys
· Customer invoices on the POS
· Customer quotes

Managing lay bys
Click "Customer" then the "Laybys" button. You can select a regular customer on the POS
prior to selecting Lay bys. If you do the lay by form will display their lay by information. In the
following example the customer has no lay bys.

To create a new lay by click "Maintain lay by".

· Enter an instruction. This helps to identify what the lay by is for as well as when it is likely to
be picked up. Or shipped.

· Leave the Lay by date as default - the day you create it.
· Enter the proposed pick up date. This is to help identify when the lay by should be fully paid.
· Because the above example already has an item on the lay by you can see that nothing has
been paid from the lay by.
Now select items (you can have more than one) that the lay by is for.

· Select an item to include on the lay by.
· If required change the number of items being set aside.
· NOTE - once an item has been set aside on a lay by you can query which items are on lay by
in Stock Management by clicking the "On lay by" button.
To make payments off a lay by. This includes deposits.

· Select the customer on the POS. Click "Reg cust".
· Click the "Lay bys" button at the bottom of the POS.
· Select the lay by (if there is more than one) the payment is for. If the customer is making
payments for multiple lay bys you need to select each lay by and allocate the payments
accordingly. It is much easier simply to restrict customers to only one lay by at a time and have
multiple items on each.

· Click "Make payment".

· Enter the amount of the payment. The payment field always defaults to the balance due. So
you will need to change it if that is not being paid.
· The box "Release lay by and update inventory" is checked if the balance owing is being
paid. As below.
· Lay by payments are identified as such on the docket.

If the customer decides not to proceed with the lay by, and you agree to a refund of money so far
paid, then enter the amount as a negative figure by selecting the lay by and following the "Make
payment" action.
The POS will then appear with a refund. As follows:

When the lay by is fully paid and the item(s) drawn from inventory the POS appears as follows:

Note that the stock item has no price displayed on the docket list. Once the lay by has been
completely paid and the stock items released it is deleted.
From the lay bys form you can also review previous payments and print receipts - either A4 or
receipt printer.

Customer invoices on the POS
Creating customer invoices
1. Select a regular customer from the POS. Their name must be at the top of the docket. They
must have been set up as an "invoice customer". Notice that the customer selected has a credit
limit of $1,000.00. And hasn't used any of it. So far.
NOTE - "credit limit" doesn't apply to credit notes. As, in that case, you owe them money.

2. Add the items they're purchasing to the docket list. As above.
3. Click "Other tender".

4. Click "Invoice/ cr. coupom". The following form activates.

If you want to generate both an invoice and order (for warehouse/store staff) then click "Create
invoice and order". Other wise click "Create invoice". You may change the payment due date
and description.
Generally you would leave "Tax exempt" unchecked.
If you have a default set of notes you always include with invoices (eg instructions relating to
warranty or bank account) then click "Include notes" BEFORE you click "Create invoice".
A confirmation popup advises you the invoice was created successfully. And includes the number
of the invoice.
5. You may now print the invoice. NOTE - you may print to the default receipt printer (as below)
or can select an A4 printer.

· Select the printer from the drop down list.
· Click "Use printer" to connect the correct printer.
· Click "Preview" if you wish to preview the invoice. Obviously there is no going back at this
point.

Paying customer invoices on the POS
1. Select the customer the invoice payment is for. Click "Reg cust".

The above example shows that the selected customer has a total of $219.19 to pay.
· Click "Invoice payment".
· The "Stock list" button becomes "Invoice list".

Click that to select the relevant invoice. You can select one at a time. Multiple invoice payments
can be made through the POS.

· Note that the POS has gone to manual mode as it is possible the payment may only be a
partial one.
· Once the invoice has been selected, and assuming the full payment is being made, click
"Accept".

· The docket list will now look something like the following

· Process tendering as normal. You can add more items to the docket as well as pay from
multiple invoices. But each invoice has to be paid individually.

Customer quotes
You can generate customer quotes from the POS. To do so click "Customer" then "Quotes".
First make sure you have set up the customer. If the quote is a likely one off, and you have lots
of those, it is a good idea to create a "Quote customer" rather than having to create a regular
customer for every casual enquiry you get.
As you can see from the below example the customer on the POS is the same as the customer

on the quote.

· To create a new quote click "Add"
· The quote id is allocated automatically. You can configure what goes there in Stock Control.
The number is the
Optionally enter a purchase order number.
Enter the date the quote is to be valid to.
Leave the Date as the default.
Enter a description. This is important for identifying quotes. Especially if you often generate
them and need to select from a list.
· Click "Save".

·
·
·
·

Now you need to enter the details. For the details you can specify anything or select items from
the inventory.

· In the Details group click "Add".

· If the detail is not a stock item type a description into the Description field. If it is go to the
Stock code field and either type a code or select the item from the stock list by clicking the
button with the magnifying glass.
· If the item is in stock the unit price defaults to the retail price. You can over ride that if you
wish.

· The above example has no buy or trade price entered.
· If you wish to provide a discount enter that into the Discount field.
· Units will have something in it if the item has a unit of measure entered into stock.

· Change the no of units if you need to. The Charge changes as you do so.
· Click "Save" to return to the quote form.

Action center
Actions are to enable you to specify when, and why, and for whom, certain actions will be carried
out. For example warranty servicing.
Activate the actions center by clicking "Action center" after "Customer operations".
The following form activates.

Actions are displayed based on their status and the date they are to be actioned. They can be
open or closed. The default is to display all actions.
To edit an, or create a new, action click "Maintain actions".

From this form you can maintain/create actions, maintain customers and create a report of
actions.
Select the customer the actions are to be for. If the customer displayed is not the one you wish to
operate on.
To maintain an action click "Maintain actions" - what else? If there are no actions the
maintenance form will have nothing on it. Other wise the selected action (if more than one has
been set up) displays.

·
·
·
·
·
·
·
·
·

Click "New" or "Edit".
If the action is for, or related to, a stock item enter/select the stock code or bar code.
Enter, or modify, the description. This should describe the action to be taken.
Enter a serial number if required.
You may enter up to two alternate ids if the stock item/ action requires. In other words the
action can use up to 3 serial numbers to identify the item it relates to.
Enter the "starts" date. This defines when the action is to begin. It may be the same as the
"Finishes" date. The start date is used to trigger warnings of actions due.
Optionally enter start and finish times. You can use these to help track staff availability and
timetabling. The default is 12:00.
If a payment is due once the action has been carried out enter that. This is for information
purposes.
Leave Closed unchecked until you are ready to close the action off. Once the action is closed
it will still appear on the actions list if "All" is selected.

It is a good idea, if appropriate, to simply "roll over" actions that are to occur regularly - just
change the start and finish dates, There is no need to keep creating actions under those
situations.
From the Action Center you may maintain customer invoices and customers, phone list, contact's
actions reminder list and addresses.
You may also email a reminder of any due action to the relevant customer. You need to have
installed an email client to be able to do this.
When you click "Customers" the maintenance form activates with the customer of the selected
action already selected.

You may add, or edit, any customers.
Reminders are set up in customer contacts and can be viewed and, if desired, emailed to the

relevant contact

This list includes all historical reminders plus reminders up to 30 days in the future.
The above list includes old reminders. To remove them go to the relevant customer contacts and
delete the notes in the contact. Or, if the reminder is still relevant, change the date. Click
"Contact".
If the contact has an email address click "Email" to activate the email form so you can send a
reminder. NOTE - make sure you have entered an email address in Company Control and that
an email client has been installed on the computer.
To list existing phone numbers and email addresses (for both customers and their contacts) click
"Phone list". The list shows all customers plus their contacts.

Registrations
Registrations are the same as actions. This button gives direct access to action maintenance.

Deliveries
This button allows you to print a list of current orders due for delivery. Make sure you have an A4
printer attached if you wish to print the report.
These orders must be built using the Customer order function. In the example below none have
been placed.

Loyalty rules
To access loyalty rules you must have administrator access rights.
More than one loyalty rule can be set up - for example you may wish to have more than one level
of loyalty.
Once loyalty rules are set up you need to connect regular customers to the rule in Customer
Operations/Maintenance. This means you may have to manually set up older customers that
were created prior to the loyalty rule being set up. Click "Sale/loyalty" on the Customer form.

· Click "Add" to create a new loyalty rule.
· Enter a description. This helps identify the rule if you have more than one and are allocating
·
·
·
·
·
·
·
·

to customers.
Enter a short description. This is used in the loyalty selection list.
Enter the date the rule is to be open from
Enter the date the rule is to be closed on.
Enter the maximum number of points permitted. This is the maximum number of points any
customer can accumulate before they have to apply the point to redeeming the points against a
sale.
Enter the sale value trigger. This is the minimum value of any sale required to trigger the
application of loyalty points. The example applies loyalty points only if the customer is buying
goods to a total value over $20.00.
Enter the sale value of each point. The example has "0.0010" cents per point.
OR enter how many points there are in a dollar.
Enter the minimum number points that must be accrued before any points can be
redeemed.

· If you check "Clear points balance on redemption" then any remaining points balance after
redemption will be zeroed.

· Enter "First number" and "Last number". This is to ensure cashiers can match the customer
loyalty card to the specific loyalty rule. If you have not generated the loyalty cards then provide
these two numbers to your printer. Or alter them once you have the cards.

Invoice payments
You need administrator's access right to use this function.
This list allows you to query what invoice payments have been made and what are still due.

In addition you can add payments and edit existing ones. If you delete a payment the POS
receipt record will still show the payment as having been made. So you really should arrange a
refund under those conditions. Unless, of course, the invoice is being dealt with entirely from
Back Office.

Customer orders
Access customer orders from either back office Customer Operations, Stock Management or
from the POS Customer Operations -> Customer orders tab.
If the items ordered are linked to suppliers it is possible to consolidate customer orders into
supplier orders.

· Click "Add order" to create a new order.
· "Order no" is created automatically.
· Select the customer. Once they have been selected their postal address displays in the
Address field.
· Enter a description of the order. While not required it is a good idea to do so. Especially if you
have multiple orders for customers and need to be able to tell the difference between them.
· The date defaults to the current date. There is no need to change it.
· Enter the date of planned delivery. This can be used to check when orders should have
arrived. In the POS customer operations form.
· Leave "Invoiced", "Closed" and "Placed" unchecked.
· Click "Save order".
You may now include detail lines. Click "Add line".

· Select an item to order. You can create new stock items by entering a new code and
description.
· If the item already has a price it displays in the Price per unit field. If you change this price
that will also change the price in the inventory. So. be careful with that. The retail price IS NOT
included when the consolidated order is sent to the supplier.
· Enter the Qty ordered. You can leave the rest unchanged.
· To add another item click "Save and add". Other wise click "Save".
From the customer order form you may carry out the following operations:
1. Generate an invoice from the order. After that has been done the order is shown as "invoiced"

and is also closed.
2. Email the order to your customer to confirm it.
3. Print the order - as either an A4 or 80mm receipt (if using Retail Business).

Processing orders
To process orders two conditions must be met:
1. All stock items must be connected to a supplier.
2. There must be unprocessed customer orders.
Processing orders has the effect of consolidating all customer order items (that have not, yet,
been processed) into a single order for each supplier. If there are any items on orders that don't
have a connected supplier those items will not be consolidated..
To consolidate customer orders into supplier orders click the "Process orders" button in Stock
Management;
The following form activates

· Select the supplier the order is to be for.
· Check supplier has open, unplaced, orders. This displays under the supplier code field as
above.
· Click "Run". A new supplier order will be created. The description will be "Consolidated
supplier order". As below:

Once all the items in the current, open, customer orders have been added to supplier orders they
are shown as placed. As below:

